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SUMMARY 

In this thesis, we summarized our findings of the modelling of a building in 

Autodesk Revit and Graphisoft ArchiCAD. These are both BIM-software 

applications. BIM stands for Building Information Modelling. 

The building we have been modelling is the ‘State Office Building’. This building 

is part of Seinäjoki’s famous City Centre, designed by renowned architect Alvar 

Aalto. To work with BIM, We had to acquaint ourselves with Finland’s guidelines 

concerning BIM. These guidelines are written down in a series of documents, 

called COBIM2012.  We also checked the dimensions of the building. We did 

some exterior measuring with a laser meter, to determine if we could use the 

old architectural plans of the building as a basis. We were also able to follow a 

group of professionals from the Finnish Geospatial Research Institute when they 

took laser scans from the City Centre. The approaches of both Revit and 

ArchiCAD appeared to be quite similar to each other. But there were also some 

differences. In Revit, the somewhat higher learning curve and smaller object 

library resulted in a lesser progressed model. However, the parts that were 

modeled have a great accuracy due to the flexibility and freedom of the Family 

Editor. In ArchiCAD on the other hand, due to the availability of the huge built-

in library, we were able to get a lot of detail in the model very fast.  

Although we were new to the software, we got some satisfactory results. We 

learned a great deal about the modelling-possibilities of both Revit and 

ArchiCAD. To put things into perspective, we eventually used only a fraction of 

the features of both software packages. We did not get, for example, into 

energy analysis, the making of sheets, the 2D-capabilities, cooperation 

possibilities, MEP and Structural analysis, etc... This was a matter of making 

choices. One of the reasons is because we specifically wanted to focus on the 3D 

modelling-part of the software. Another reason is that it is impossible to learn 

everything about two different software packages in 4 months. We thought it 

was far better to focus on a small part of the software and to pursue quality. 
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INTRODUCTION 

As students in the field of construction, we always need to acquaint ourselves 

with new ideas and principles. The last years, a new way of building has become 

more and more popular. This new approach is called Building Information 

modelling, or in short BIM. Although, the idea of BIM already exist for a long 

time, it really got a boost in the last decade. One of the reasons of this boost, is 

the upcoming popularity of BIM software packages like Autodesk Revit and 

Graphisoft ArchiCAD. As of this year, our university college offers the first-year 

students the possibility to work with BIM-software. Also great investments were 

made with the MoreBIM project at our school, to do research in the field of BIM, 

adopting it in the Belgian Construction industry. As this is very exciting, we also 

wanted to get to know more about working with BIM-software. 

Because we were new to BIM-software and its modelling-capacities, we decided 

to use both Autodesk Revit and Graphisoft ArchiCAD to model the State Office 

Building in Seinäjoki, Finland. We used these particular software packages 

because they are currently the most used BIM-software in the world. Because 

we had no prior experience, it was interesting to research if there were big 

differences between both software packages. We were also interested in the 

differences in outcome with both Revit and ArchiCAD. Another interesting field 

we wanted to get to know better is how to approach the modelling of an existing 

building. 
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1 SEINÄJOKI UNIVERSITY OF APPLIED 

SCIENCES 

In the last part of our education, we had the ability to go to Seinäjoki University 

of Applied Sciences. A university in a somewhat small city in Finland called 

Seinäjoki. The School of Technology, which is a department of the University of 

Applied Sciences, is well known around Finland for its 3D research.  

1.1 General information 

Seinäjoki University of Applied Sciences, in short SeUAS, is a multidisciplinary 

university located in Seinäjoki, Finland. The university has a total of 20 Bachelor 

and 7 Master degree programs. One of these bachelor degrees is construction 

engineering. At this moment, there are around 4800 active students in the 

university. In addition, there are 400 staff members.  

Internationalization is an important aim of the university. They have more than 

200 partner universities and networks in almost 50 countries. An extra addition 

to the university and their international aims is that 3 bachelor degrees are fully 

taught in English.  

 

 

Seinäjoki UAS is mainly located on three campuses. The Frami area is the main 

campus of SeUAS and serves all the needs for around 3000 students. The fields 

of education on Frami campus include technology, culture and design, business, 

hospitality management, social work, elderly care and forestry. Of the other 

campuses, Koskenalantie campus has 600 health care students and Ilmajoki 

campus gives 400 students all the necessary education in the field of natural 

resources.

1.2 The CAVE 

Our work environment and place to have meetings was mainly the Cave 

Automatic Virtual Environment, in short CAVE. The CAVE exists of 5 projection 

surfaces that are 3.0 by 2.4 meters. By projecting the virtual environment on 

these 5 surfaces, you get a complete sense of immersion in that environment. 

To experience the 3D view, you will need to wear stereo glasses and trade your 

shoes for slippers. The slippers prevent that the floor side of the projection-

surface gets damaged. 

The CAVE can help people to understand and perceive details in an easy way. In 

our work field, it is being used to show all kinds of 3D computer generated 

buildings, rooms and environments. But the CAVE is capable of doing more than 

that. It is not only used for construction & architectural purposes, but there is 

Figure 1.1 – Aerial image of the Frami campus of SeUAS (source: SeAMK) 
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also an extra value on the fields of urban planning, factory site design, 

simulation, engineering, industrial design, medicine, geology, astronomy, 

culture, history and entertainment.  

The CAVE is not only used for educational purposes. For example, there has 

been cooperation between the city of Seinäjoki and the University in multiple 

projects. A certain project was the design of the new library of the city. The 

CAVE made it possible to walk through the new designed library to ensure that 

all the desired characteristics were included in the final design. For example, the 

view from the inside of the new library towards some of Alvar Aalto’s creations 

was tested in advance. Another concern was that the new library would cover 

the view from the streets towards Alvar Aalto’s Centre. With placing the model 

in the virtual environment, they found the right place to build the library. 

The virtual world is still developing rapidly. So apart from the 3D modelling in 

the CAVE, there are still a lot of other projects going on in the Virtual 

Laboratory. The Oculus Rift, Phantom Omni and Unity are some of these 

technologies and are followed very closely. These things are already very 

important in the virtual world and still have a huge potential. 

The project where the most students have been working on is probably The 

Virtual Seinäjoki. This project started in 2005 when the Seinäjoki planning unit 

ordered a 3D model of some particular buildings of the city. The collaboration 

with the city for this project ended after a few months, but the project is still 

going on. A lot of students have been modelling one of the buildings here in 

Seinäjoki. The model is currently having around 140 models and is available for 

everyone to watch on Google Earth. The model is also fully viewable in the 

CAVE, so we have been lucky to watch and experience the virtual city in the 

CAVE. 

 

Figure 1.2 – Demonstration in the CAVE 
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2 STATE OFFICE BUILDING OF SEINÄJOKI 

In our quest to find an interesting subject for our final thesis, we always talked 

about our desire to model one of Alvar Aalto’s buildings. So we were very happy 

that the State Office Building could be part of our final thesis. This building was 

one of the latest buildings in the Administrative and Cultural Centre to be 

completed. The building consists of 4 stories and is mainly used as office 

building, but a few years ago the building was also used by the police and tax 

department. The building’s ownership was transferred to the city in 2003. 

2.1 The building 

The building forms the Western terminus of Aalto’s plan for the City Centre. His 

idea was to design an ending to the group of buildings. The construction period 

started in 1966 and ended in 1968. The building consists of 3 stories above 

ground level and a basement. It has a floor surface of more than 6000m². The 

courtroom is the most noteworthy room of the building. You can see a lot of 

Alvar Aalto’s influences when you walk around. The door handles, lamps, 

furniture and finishing of the walls were all designed by Alvar Aalto himself.  

The outside of the building is almost 

fully covered with white plastering. 

Since the building is almost 50 years 

old, you can see that the building 

needs a restoration. As the City 

Library is in restoration now, the State 

Office Building will be the next one in 

line. In that case, our model could be 

useful as a basis for that restoration. 

 

In order to model the building we received the original plans of the building 

from the Alvar Aalto Foundation. They take care of Alvar Aalto’s material and 

heritage and store all this information in a museum located in Jyväskylä. 

 

Figure 2.1 – Alvar Aalto’s Centre (source: Seinäjoki) 

Figure 2.2 – State Office Building 
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2.2 Alvar Aalto 

Alvar Aalto (3 February 1898 – 11 May 1976) was a Finnish architect and 

designer. His work includes architecture, furniture, textiles and glassware. Aalto 

graduated with honours from Helsinki Polytechnic in 1921 after which he opened 

his own practice in Jyväskylä.  

2.2.1 Alvar Aalto’s Centre 

The Administrative and Cultural Centre, completely designed by Alvar Aalto, is 

the pride of Seinäjoki. The centre consists of 6 buildings and are mainly 

completed between 1960 and 1968. Alvar Aalto already made his introduction to 

Seinäjoki in 1925 when he designed the Seinäjoki Defense Corps Building. 

 The “Cross of The Plains” church and the Parish Centre 2.2.1.1

So how did Alvar Aalto end up back in Seinäjoki after all those years? As a result 

of an architectural competition in 1951, Aalto’s design was chosen to be 

constructed. But the construction of the church did not take place until 1957-

1960 due to financial problems. The additional Parish Centre was constructed 

during 1965-1966. Our predecessors, Laura Peeters and Bart Vermeiren, 

modelled the church back in 2011.  

 Town Hall 2.2.1.2

The competition for the City Centre, including the Town Hall, took place during 

1958-1959. The Town Hall was constructed in 1962 and has a remarkable 

façade. The façade is covered with ceramic tiles, an element that is also used for 

the State Office Building. The ceramic tiles glitter differently according to the 

time of the day and the season. 

 City Library 2.2.1.3

Based on the design of the Town Hall, Alvar Aalto was also asked to design the 

library, theatre and administrative building. The City Library is constructed 

during 1964-1965. The library has been completely restored to its original state 

and is planned to be open again in the summer of 2015. They will also complete 

an underground connection between the old and the new library. 

 Seinäjoki Theatre 2.2.1.4

Alvar Aalto already drafted the preliminary design for the theatre back in 1968. 

These plans were updated to the more modern needs of a theatre. The theatre 

was finally constructed in 1987 under the lead of Alvar Aalto’s wife Elissa Aalto. 

 

 

 

 

 

1. Church  

2. The Town Hall  

3. The Library  

4. The Parish Centre  

5. Office Building  

6. The Theatre  

1960 

1962 

1965 

1966 

1968 

1987 

Figure 2-3 - Site plan of Aalto’s Centre (source: Seinäjoki) 
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2.2.2  Alvar Aalto’s career 

It is estimated that Alvar Aalto designed approximately 500 buildings during his 

50-year career. Around 400 of them are built in his home country Finland. He 

started his career with classicistic designs, changed to modernism and ended his 

career with some monumental buildings. 

    The first steps 1920-1930 2.2.2.1

When starting his career, Aalto designed family houses in the so-called Nordic 

Classicism. During this period he also completed his first public buildings 

including several churches. The Seinäjoki Defence Corps Building is a good 

example of one of Aalto’s designs during this phase of his career. 

 Modernism 1930-1960 2.2.2.2

The Viipuri Library characterizes the shift in Aalto’s design, from classicism to 

modernism. The library went through a whole transformation. It went from an 

originally classical design to a complete high-modernist building. Thanks to the 

Paimio Sanatorium and Viipuri Library, Aalto achieved his first worldwide 

attention in architecture. These buildings were significant milestones on the way 

to modernity. It was characteristic of Aalto to treat each building as a complete 

work of art, including the furniture and light fittings. 

 Late career 1960-1976 2.2.2.3

Between 1960 and 1970 Aalto's work began to pale in colour. White plastering 

and ceramic tiles gave his buildings a new character. These features are easy to 

recognize in all the buildings that are part of the Alvar Aalto’s centre in 

Seinäjoki. In the last decade of his life, Aalto was still an active and influential 

architect. One of his last famous works to draw, was Helsinki’s Finlandia Hall, 

which he was contracted to draw in 1962. Although Alvar Aalto died almost 40 

years ago, the furniture design company he established still sells many of his 

designs today. 
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3 MEASUREMENTS 

Our first job was checking the original plans. How accurate was the building 

constructed back in 60’s? The main goal was to check the outer dimensions of 

the building, so we could see if the plans we used, were accurate enough.  

During one of our last weeks in Seinäjoki, we were able to follow a group of 

professionals from the Finnish Geospatial Research Institute for 2 days. They 

came to Seinäjoki to laser scan Alvar Aalto’s Centre and the new library. The 

generated Point Cloud Data however, is not used. The reason for this is that we 

did not have enough time to properly import the data into our models.  

Nevertheless, it was very interesting to have been introduced to these modern 

techniques. In our future careers, we will certainly make use of these new 

technologies. We have, however, investigated how we could use the data in our 

models.  

3.1 Checking the plans 

3.1.1 Used equipment  

1. Leica DISTO Plus (range of 200m) for measuring outside 

2. Fluke 411D (range of 30m) for measuring inside 

3. Manfrotto tripod 

4. Tape ruler (length of 8m) 

3.1.2 Measuring 

The first laser distance meter has been invented more than 20 years ago. From 

that point, it became a much used and important tool in the construction field. 

You can measure every short and long distance in a very fast and easy way.  

We decided to measure as much distances as possible. Because we had a devise 

that has a very long range, we tried to capture the whole length of a façade 

from one point. We worked from a corner of the façade. Because of this long 

distance, we used a tripod to have maximal control over our laser point.   

An overview from the results of our measurements can be found in appendix 1. 

When we checked the final results of the measurement of the upper façade, we 

could see that the difference between the plans and the actual measurements 

are small. We had an average deviation of 2,33 cm and had only a deviation of 

1,2 cm for the whole length of the façade.  

At the bottom façade we had almost the same result with only an average 

deviation of 2,433 cm. We saw a deviation of 0,4 cm for the whole length of the 

facade. With taking the margin of error of the laser meter, human error and 

construction faults into account, we can conclude that we can trust on the outer 

dimensions that are stated on the original plans. 
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3.2 3D Laser scanning 

3.2.1 Principle  

 Theoretical  3.2.1.1

A 3D laser scanner will measure the environment with high speed scanning. The 

laser scanners that were used for the measurements are FARO Focus3D X -

devices, which can scan up to 976 000 points/sec and have a range of 330m. 

These measured points will form what is called a point cloud. The point clouds 

will not generate your 3D model itself, but can be used as a handy tool. The 

laser scanners are not yet able to scan the type and thickness of a certain 

building-component, but hopefully they will in the near future. You can use the 

point cloud from the beginning and trace over it or use it afterwards to check 

how accurate you have drawn your model. 

But is it profitable to scan a whole building? It takes a lot of time and money to 

scan such a large building. We’ve been scanning for 2,5 hours and used 3 laser 

scanners. In that time, we have only been able to scan the largest parts of the 

hallways and the courtroom. Maybe scanning the whole building would be 

overkill, as the basic structure can easily be modelled without the point clouds. 

Scanning and using point clouds for parts of the building can be useful. 

Especially for complex details or for piping packages. 

 Practical 3.2.1.2

Setting up the laser went fast and did not take that much effort. The laser 

scanner has a simple and clear interface. Here you have to define the resolution 

and the quality. Selecting a higher resolution and quality will obviously get you a 

longer scanning time. In our situation, they chose for a medium resolution and 

quality, which got us a scanning time of 2 minutes per scan. To give an 

indication, picking the highest settings will get you a scanning time of 

approximately 30 minutes per scan.  

Figure 3.2 – Measuring the East façade  Figure 3.1 – Leica DISTO Plus 
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The last important thing that had to be set up before the actual scanning, were 

the target points. These points need to be in range of the laser scanners, so we 

are able to assemble the different scans into one point cloud. So when we 

moved the laser scanner to another area, the laser scanner needed at least 2 

target points from the previous scan. You need to have this ‘rule’ in mind for 

every scan you do. Therefore, you have to have some sort of ‘walk around’-

strategy, to optimize the scanning-procedure. 

Besides the scanning of the inside of the State Office Building, we have been 

able to see two other scanning platforms. The first one scanned the outside of 

the site with the laser scan material attached to an ATV/quad. The scanning 

devices that were used, were the same as the ones used on the inside of the 

building. The second one scanned the outside of the buildings with an 

UAV/drone. The flight plan was set up on a tablet/pc and was uploaded to the 

UAV right before takeoff. The UAV scanned the area based on the imported 

flight plan. The AUV flew on automatic pilot. The landing and taking off, 

however, was done manually. The technical details of the performed laser 

scanning in Seinäjoki can be found in appendix 2. 

  

3.2.2 Using point clouds for modelling 

 ArchiCAD 3.2.2.1

ArchiCAD 18 has no integrated function that makes it possible to import point 

clouds. A company has developed a program, called Points4BIM, that makes it 

possible to work with points clouds in ArchiCAD. But it is still not possible to 

insert point clouds directly into ArchiCAD. You will have to run both programs 

and import the point cloud in Points4BIM. Points4BIM creates a connection 

between both programs, which makes it possible to work with the data of the 

point cloud in ArchiCAD. 

Graphisoft has announced that ArchiCAD 19 will have point cloud support. This 

is one of the biggest new features, making it possible to import point clouds 

with the standard *.e57 or *.XYZ format. 

Figure 3.3 – Target points Figure 3.4 – UAV laser scanner 
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 Revit 3.2.2.2

Revit already supports point cloud import for a few years. Importing can be 

done in a wide range of formats. The best format to import point clouds into 

Revit is *.pcg. This file format is the least demanding for the system hardware. 

Every year, point cloud support is updated, since it is still a technology with 

many growing pains. We have been able to get some images of the point cloud 

scan of the ATV. You can see that the roof structure is missing, as well as a part 

of the second floor. This is because these parts are not visible from the ground 

floor. To also visualize this part, the UAV-data can be used.  

 

 

 

 

 

Figure 3.5 – Point cloud from the State Office Building (source: NLS) 

Figure 3.6 – Close up of point cloud from the State Office Building (source: NLS) 
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4 COBIM 2012 

Although the main focus of our thesis is on the 3D modeling-part, it is 

interesting to have a look at the practice of Building Information Modelling in 

Finland. First of all we should ask ourselves what this ‘BIM’ actually is. In a way, 

you can look at it as some sort of simulation of a building process. This 

simulation is performed using a centralized model from which eventually all data 

is collected to make plans, schedules, estimations, visualizations, planning, etc. 

From this simulation, the different building parties could learn a great deal and 

alter some of the initial workflow. You could say that you can learn from your 

mistakes before you actually make them. Also because you work with one 

central simulation-model from which all plans and schedules are derived, you 

minimalize misunderstandings during the building process. On the other hand, 

because all the building parties are tightly linked to each other and depend even 

harder on each other’s work, the understanding of the process is primordial. 

Because the building-process involves so many different players, you need some 

kind of common rules to begin with. The Common BIM Requirements 2012 or in 

short COBIM are a series of documents that serve as a framework for BIM-

projects in Finland. The series of documents are divided in 13 general parts or 

series and are also available in English. You can access them for free and 

download them from the Finnish part of the buildingSMART website.  

Part 1 of the series gives us a good insight in how the series are built up. The 

concept of BIM and the advantages that a BIM-workflow can have are explained. 

For example a BIM supports investment decisions in an early stage of a 

building-project. Also lifecycle analyses can be performed more easily, it aids 

design visualization, improves quality insurance and makes usage of the data 

possible for facility management later in the building process.   

Further in this part there is a topic about the technical requirements for a BIM-

based project. The usage of the platform-independent IFC-format for 

exchanging building-information is mandatory. Also the usage of a common 

coordinate system and the usage of the same measuring unit is stressed in this 

part. The usage of the proper and intended design-tools in the software is 

important. For example: a column should be modelled using the column tool 

instead of drawing a very short piece of wall. Other examples are made as well.  

The role of the BIM coordinator is also partly defined in this part. It is essential 

that someone overlooks the whole BIM building process and this coordinator 

serves as a connection point between the different parties in the BIM-process.  

The problems that arise in BIM-projects are often of a technical nature, so a 

thorough knowledge of BIM software and processes are very important.  

In each of the series 2 to 13, a particular subject is covered. 

 In “series 2: Modeling the starting situation”, we get some information on how 

the starting situation should be measured and modelled. This starting situation 

can either be a new plot or an existing building. In this series there is a part ‘4.1 

measurement requirement, content’ which informs us of the different methods 

of measuring and their uses. There are possible 3 levels for measuring the initial 

state of the building or the plot. Level 1 is the usage of a laser meter, a method 

we performed on the State Office Building. If you want to base your model on 

old drawings, like we did in our model, you should check the stated 

measurements on the plans by going in the field and do some control 

measurements. If there aren’t any alarming differences, you can base yourself 

on the old drawings. Level 2 is the usage of a Tacheometer. Level 3 is a laser 
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scanning survey. How the information in level 2 and 3 can be processed and 

what it is used for, you can find here as well. On the modelling part, the same 

rules apply as stated in the general part. You should always use the right tools 

for the right building components. 

In series 3 to 5 respectively architectural, MEP and structural design are 

covered.  The architectural model serves as a starting point, so it is very 

important that the correct modeling- methods are used.  At the end of this part 

of the series, we can find a document called “Architecture Model Content 

Requirements”, in which the content requirements and Level of Detail (LOD) are 

stated and recorded. Also for MEP and structural design in series 4 and 5, there 

is a similar document.  

Series 6 covers the assurance of quality. This assurance can be viewed from 

different perspectives. Each perspective is covered in this series. From the 

client’s point of view, it is primordial that potential issues are found and 

corrected as soon as possible. The content requirements have to be checked, so 

that they correspond with the demands in the initial design. IFC is utilized for 

these tasks. From the designer’s point of view, it is very important to further 

develop his/her knowledge of the BIM-process. This way overall quality will 

improve, but this requires a constant adaptation and assessment of the 

delivered work. Finally you have the quality-improvement of the designer group.  

This is mainly achieved by improving communication-skills between the different 

parties. For each of these views, a series of tasks and ‘to do’s’ is formulated.  

Further in this part of the series, the different quality assurance methods of 

‘checking’ and ‘analyzing’ are covered. The BIM files that should be checked as 

IFC-models, and what each BIM model minimally should consist of, is stated in 

‘6.3 BIM files to be checked’. The BIM models are respectively the Inventory 

BIM, Spatial BIM, Building Element BIM, System BIM and merged BIM. At the 

end of this part, we find how the responsibilities should be divided. There should 

be someone who overviews the quality of the entire project, authorized by the 

client. There should also be a responsible in each design-team, to follow up the 

internal quality of the team. 

In series 7, quantity take-off is covered. A BIM-model can provide a great deal 

of information to measuring quantities. In this part of the series, we will not find 

actual instructions on how to take quantities in a BIM-model. It is more to give 

an idea of taking quantities in the model. 

One of the important things when taking quantities of a model, is checking the 

consistency of the model. If a model is poorly or inconsistently made, some 

problems can arise. That is why all components in the building need to be 

modeled as agreed to in the BIM requirements document. Also arisen difficulties 

or certain types of decisions should be logged in the specification-document.  

That way, the quantity surveyor can adapt when quantifying. Another fact that 

should be taken into consideration is the level of detail (LOD). Throughout the 

project, the BIM-model and its components are modeled to a certain LOD. LOD’s 

of components can change throughout the process, as required in the different 

construction- phases. This should be taken into account when quantifying.  As 

stated before, the reason why certain building-elements should be drawn with 

the appropriate tools in the BIM-software is to make correct quantifications. 

Series 8 is about visualization. Because BIM also includes a 3D-model, it can be 

used for representation purposes. In this part of the series, they make a 

distinction between a technical illustration and visualization. The first kind 

serves more as a (technical) communication tool between the different players 

of the BIM-team. The (photorealistic) visualization on the other hand can 
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represent the designer’s view project and the different design solutions. In 

series 9 and 10, we can read about how preliminary analysis of the building’s 

design solutions, can aid the decision-making in a later stage. These analysis or 

simulations, like for example the investigation of comfort level, airflow, energy 

consumption, environmental impact analysis, ergonomic approaches, lighting 

simulation, can aid a great deal in the eventual outcome of the design. 

Series 11 is goes deeper in the managing–aspect of BIM. Coordination is one of 

the key-aspects of a successful BIM-project. In this part, we can find some 

principles of information model-based project management. The process is 

explained, and the different roles, like the BIM-coordinator, are specified. The 

different stages of a BIM-project are looked at. These are stages like conceptual 

design, design preparation, design control, construction preparation, control of 

construction, commissioning/handover/takeover and the Warranty 

period/operation/maintenance-stage. This last phase is further explained in 

‘series 12: Use of models in facility management’. Finally, in Series 12, COBIM 

tries to give a deeper understanding on how the models should be used in 

construction. This is because the construction- and production -needs of the 

information models are specific and change, depending on the phase of the BIM-

project.  

Throughout the series, different principles about BIM are returning items. 

However, the scope is always a little bit different. 
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5 3D MODELLING 

After checking the dimensions of the building, our next step is to start modelling 

in Autodesk Revit and Graphisoft ArchiCAD. Both software companies have been 

investing in BIM-software for a long time. Hungarian based Graphisoft already 

ignited the BIM revolution with ArchiCAD in 1984. After more than 30 years of 

development, Graphisoft has come to the 18th version of ArchiCAD. The 

software is recognized as the first CAD product on a personal computer able to 

create both 2D drawings and parametric 3D geometry. The first version of Revit 

was designed in 1997 by a company called Charles River Software. In 2002, 

Autodesk purchased the Revit-technology. This year, version 2016 has come 

out, offering Architecture-, Structure-, and MEP versions. With both ArchiCAD 

and Revit, you can create a 3D Building Information Model, from which you can 

create all the necessary documentation and images automatically. For this 

project, we ran ArchiCAD 18 on Apple’s OS X Yosemite and Revit 2016 on 

Microsoft’s Windows 7 SP2 64-bit. 

Table 5-1 - Used computer hardware 

 Revit ArchiCAD 

Processor Intel Centrino Duo T7500  
2,2 GHz 

Intel Core i7 2 GHz 

Memory 4 GB DDR2 16 GB DDR3 

Graphics card AMD Radeon HD2600 
256 MB 

AMD Radeon HD6490M 
256 MB 

Hard disk 250 GB SSD 500 GB HDD 

5.1 Getting started 

Before we could start the actual drawing-process, we needed to get to know the 

software-packages first. Initially we were only going to model a building in 

ArchiCAD, exploring all the possibilities of the software. While we were 

searching for an appropriate building to model, we started by getting to know 

ArchiCAD by doing a lot of different tutorials. Graphisoft offers many ways to 

learn their software, by offering a wide selection of tutorials. They have 5 

training series, beginning with some basics, applied on a very simple structure 

(series 1). Gradually new and more advanced topics are introduced, ending with 

the topic of ‘teamwork’ in series 5. The main free source of information for Revit 

is offered through their Revit Help-portal. Also on the Autodesk University 

website, you can find a lot of information about their software packages, 

including Revit.  

Besides the official channels of the software vendors, there are a lot of other 

paid information sources you can tap into. Also Youtube proved to be very 

helpful, as there are a lot of users sharing their experiences.  

Figure 5-1 – Overview of the training series of Graphisoft (source: Graphisoft) 
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5.2 Interface and basics 

5.2.1 ArchiCAD  

 
Figure 5-2 – ArchiCAD interface 

 Toolbox 5.2.1.1

The Toolbox shows the tools that can be used for selection, 3D 

construction, 2D drawing and visualization. The Toolbox is divided into 

4 groups: Select, Design, Document and More.  

The group Select shows 2 tools, which can be used to select elements. 

The Arrow Tool is the default tool that will be selected when no other 

tool is selected. You can select an element by left clicking on it. To 

select more elements at one time, you have to hold the TAB-key while 

clicking on the elements. With the Marquee Tool it is easier to select 

larger particular parts of elements.  

The group ‘Design’ consists of all the tools, which can be used to draw 

an element. You can select one of the design tools by just left-clicking 

on them.  

The group ‘Document’ has an amount of tools, which can be used to 

create, draw or edit a 2D document. 

The group ‘More’ consists of tools, which were not able to specify in 

one of the previous groups. The Grid Element Tool, the Lamp Tool and 

the Camera Tool are the most important tools that are located in this 

group.  

 Navigator Palette 5.2.1.2

The Navigator Palette is a tree structure that let you build up the entire 

structure of your project and navigate within it. You can create folders, then 

copy, drag and drop views and other project items, depending on their purpose. 

The Navigator Palette displays the whole project in 4 different maps. You can 

 Figure 5-3 - Toolbox 
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navigate through the maps by clicking on each one of them at the top of the 

Navigator Palette. 

1. The Project Map 

The Project map consists of a tree structure of the components of the model. At 

the top of the Project Map, the house icon represents the project and is followed 

by the name of the project. This map locates all kinds of views like the stories, 

elevations, sections, details and 3D documents. By double clicking on the views, 

they will pop up in the drawing area. 

2. The View Map 

The View Map shows the list of saved views in the project. This map consists of 

a variety of views from one viewpoint. When the project develops and is starting 

to get bigger, it is getting harder to get a clear view over the elements. The 

views are just viewpoints that will show you certain parts of the whole model. 

For example, it could be useful to only see the bearing elements or only see the 

floor or ceiling elements. You can set up any view that you want. 

3. The Layout Book 

In the Layout Book you can start organize the layouts and preparing to print the 

plans. 

4. The Publisher Set 

In the Publisher Set you set up the items you want to publish. In this map you 

define the publishing method and format. The most common publishing formats 

are PDF, DWG and IFC.  
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Figure 5-4 - The 4 maps of the Navigator Palette 

 Info Box 5.2.1.3

The Info Box is available for every tool of the Toolbox. When you activate a tool 

or select an already existing element, the Info Box will display the current 

parameters of that tool/element. If several elements are selected, the Info Box 

displays these parameters for the last selected element. 

The Info Box consists of a collection of input and parameter controls that are 

specific to the selected tool or element. All these controls are also available in 

the Tool Settings Dialog. The Info Box is a quicker and easier way to change the 

control, because it stays on the screen while you are working. For example, the 

layer, material, height and thickness of a wall are just a few of the parameters 

that can be edited in the Info Box. 

 

Figure 5-5 - The Info Box when the Wall Tool is selected 
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 Statusbar 5.2.1.4

The Statusbar is located at the bottom left of the ArchiCAD interface. It hints 

what you can do next. 

 

Figure 5-6 -The Statusbar  

 Standard toolbar 5.2.1.5

The Standard toolbar exists of the most frequently used actions. This toolbar 

provides standard actions like new file, open, save, print, undo and redo. Some 

of the actions we used the most will be explained in detail below. 

 

Figure 5-7 - Standard Toolbar 

1. Find & Select  

We can use Find & Select to select and deselect elements based on defined 

criteria. This is an easy way to select a large amount of elements without having 

to select them all separately. We can search for elements according to the 

following criteria: element type, building material, layer, fill, structural function, 

etc. 

2. Pick Up and Inject Parameters  

Picking up parameters (left icon) from an already existing element can be very 

useful when we need to draw an element with the same or slightly other 

settings. When we move our cursor over an element whose parameters we want 

to pick up. The element will highlight with a blue colour, telling us which 

element we are focusing on. When we now click, for example on a wall we want 

to pick the parameters from, the Wall Tool will be selected automatically. This 

makes it possible to directly draw a wall with the parameters we have just 

picked up. The Pick Up command can also be selected by holding the short key 

‘Alt’.  

When you have picked up parameters of an element, it is also possible to inject 

these parameters into an already existing element (right icon). 

3. Trace  

You can opt to display 2 different views together in every model and layout 

view. This is called a Trace Reference, which can be placed alongside, on top or 

underneath the actual drawing that you are working on. It acts as a kind of 

underlay, making it easy to compare multiple model views/drawings on the 

same screen. This was very useful when drawing columns and outer walls of the 

next story. This way, we could just trace, based on the story below and make 

sure that the elements were right on top of each other. 
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4. Measure  

After placing each element, we checked if they were placed on the right spot. 

Therefore, the Measure tool was very useful. This was a great way to get quick 

feedback. To use the Measure Tool, just select the icon from the Standard 

Toolbar, or use the shortcut ‘M’. 

 Menu bar 5.2.1.6

At the very top, the Menu bar lists all the available commands, which are 

divided into different groups. As Design and Documentation are separate 

processes, the tools and commands supporting these processes are also located 

in separate menus. The Teamwork menu supports collaborative work, and the 

Window menu sets the visibility of the toolbars and palettes. In the Help menu, 

you are able to find all kinds of guides and helping documents.   

 

Figure 5-8 - Menu Bar 

 Mini Navigator 5.2.1.7

With this tool, you can navigate through the stories. The first icon on the left will 

take you to the 2D view, the second one will open the 3D and the third icon will 

open the layout. When you want to specify the view that you want to open, you 

can click on the small arrow that is located on the right side of the icons.  

The options for the 2D view are shown in the figure below 5-9. The current 

selected story will be shown at the top. ‘Go Up a Story’ activates the story 

above the current floor plan. ‘Go Down a Story’ takes you to the story below the 

current one. ‘The Go to Story’ command opens a dialog box, allowing you to fill 

in the number of a story. This can be very useful when we have a large amount 

of stories. We can start the Orbit- and Explore Mode with the 2 remaining icons 

on the right. 

 

Figure 5-9 - Mini Navigator 

 Zoom Controls 5.2.1.8

At the bottom of the interface, you can find the Zoom Controls. A set of icons 

helps you to navigate through the project and set the drawing scale and zoom 

factor. 

 

 

  

Figure 5-10 - Zoom Controls 

www.iiB
IM

so
lut

ion
s.i

r



31 

  

 Pet Palette 5.2.1.9

The Pet Palette is a collection of commands that pops up when you draw or edit 

an element. In most cases, the Pet Palette appears after you have placed an 

element and then select the element for further editing. Which commands 

appears in the Pet Palette depends on the following: the selected element, the 

part of the element you selected (edge, node or surface) and the active window. 

You can move your cursor over the icons to read the tool tip for each one. 

Selecting one of the commands can be done by clicking on the icon. An easier 

way to navigate through the commands is by using the shortcut ‘F’. The Pet 

Palette automatically disappears when the operation is finished. 

 

Figure 5-11 - Pet Palette 

5.2.2 Revit 

In Revit there are quiet some concepts to get familiar with, and as we were 

quiet new to the software, they could be overwhelming at times. Nonetheless, it 

was important to acquaint ourselves with some of these concepts. 

  Working environments 5.2.2.1

There are some different working environments in Revit in which you can create 

3D content. Although these are not all being used in the drawing of the State 

Office Building, it is interesting to distinct one from another. As we become 

more and more familiar with Revit in our future careers, we will certainly start to 

use each environment more intensely. Each environment has some different 

rulesets and approaches for creating 3D-content, but there are also similarities. 

We distinct 3 major modeling environments: the Project environment, the 

Family Editor environment and the Conceptual Massing environment. 

1. Project environment 

This is the typical environment, which displays when you start a new project. In 

this environment, you place system-families like walls, roofs and floors and load 

component-families like windows and doors. This will be the main setting of our 

project. There are different elements in the project-environment we can distinct. 

You can access this environment by starting a new project. To do this, we go to 

the Application Menu > New > Project. There are different elements in the 

project-environment we can distinct. 
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Figure 5-12 - Revit interface 

 

                                 

 Figure 5-13 - Project Browser                  Figure 5-14 –Properties Palette  

  

The Project Browser displays a list of all possible views, sheets, families and 

parts in the project.  

In the Properties Palette you can view and modify parameters of a selected 

element.  
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The Quick Access Toolbar is a customizable bar where you can add all kinds of 

commands, so you can gain quick access to them. This is something you can 

simply do by right clicking on the command, so you activate ‘Add to Quick 

Access Toolbar’. This is something that is highly recommended to do, to speed 

up your work. By default, this bar is shown above the ribbon. But you can 

change this by right clicking on the toolbar.  

 

Figure 5-15 - Quick Access Toolbar 

 

To further speed up your work, you should also make use of shortcuts. In our 

case, we activated most commands by short key. Some short keys are 

predefined, others you will have to add yourself. This is something you can do 

by going to the Application Menu > Options > User Interface > Keyboard 

Shortcuts > Modify. We added some ourselves, like for example Trim/extent 

Single Element (TS) and Trim/extent Multiple Element (TM). We advise to use 

short keys as your main way of starting new commands.  

The Tabs/Ribbon bar is where you find most of the commands and is highly 

customizable to serve your needs. Here you can cycle through the different 

disciplines that Revit supports, like for example Architecture, were you place 

walls, doors and windows. In the Structure part, you can add structural columns 

and beams. In the Systems-tab, you find all kids of tools to draw details MEP-

systems (mechanical, electrical, and plumbing). You can only find these 3 

displines together in de educational version. Autodesk separates these 

disciplines in the commercial versions, being Revit Architecture, Revit Structure 

and Revit MEP. 

 

Figure 5-16 – Ribbon 

 

The Drawing Area is where all the action takes place. In this area, the views are 

displayed that are listed in the project browser. By default, every time you open 

a new view in the project, it stacks on the previous view. This way all views are 

open in the background and you can quickly cycle through them.  

The View Control Bar is another bar you will often use. Here you can access the 

view-related settings, the most important being ‘Scale’, ‘Detail Level’, ‘Visual 

Style’, ‘Temporary Hide/Isolate’ and ‘Reveal Hidden Elements’.  

 

Figure 5-17 - View Control Bar 

 

By hovering over the different command-buttons, a brief explanation pops up. If 

it is still not clear, or if you are just interested to dig deeper, you can press F1 

to go to the help portal. We found the Help-portal of Revit to be a great way to 

discover the different toolsets in a non-linear way.  
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Figure 5-18 - Brief explanation of the Wall Tool 

 

2. Family Editor Environment 

 

Figure 5-19 - Family Editor interface 
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In the Family Editor-environment, you can make all kinds of components with 

the aid of family templates. Here you can make 3D geometry with some basic 

tools like for example ‘Extrude’, ‘Blend’, ‘Revolve’ and ‘Sweep’. Reference Planes 

are used to constrain geometry and add parameters to the components. Most of 

3D modelling is done using 2D views and very simple manipulation. The final 

product that you create in this environment can be imported back in the project 

environment for use in your 3D-model. This environment looks very similar to 

the project-environment. You also have a Ribbon, a Project-Browser and the 

Properties Palette. The Tabs, however, have changed. The Architecture -, 

Structural- and Systems Tab have been replaced by a Create Tab. This is where 

you will find the different kinds of manipulation tools like Extrude, Sweep and 

Revolve. 

 

Figure 5-20 - Different kinds of basic manipulation forms 

 

Under the properties-palette in the Ribbon we find important tools like Family 

Types [5-21A] and Family Category & Parameters [5-21B]. 

The Reference Plane and The Reference Line, both important tools for making a 

Component, can also be found in the Datum Panel of the Create Tab. We will go 

deeper into these tools when we actually make some geometry in the Family 

Editor (See 5.7 Revit Families). 

                   

                     Figure 5-21 – Properties              Figure 5-22 - Datum 
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3. Conceptual Massing Environment 

 

Figure 5-23 - Massing interface 

 

You can see this as a variation of the Family Editor. This environment was first 

introduced in Revit 2010. You can also create 3D-forms, but the approach is 

different. You will mainly manipulate the object in 3D and how you do 

manipulations is somewhat different. One of the purposes of using this 

environment is to explore forms and do massing studies.  
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 Elements and hierarchy 5.2.2.2

There are 3 different kinds of elements in Revit we can distinguish. First, we 

have the model elements, and these represent all the actual 3D geometry in the 

building model. Walls, windows, doors, roofs, columns are great examples of 

model elements. Secondly, we have the Datum elements. These are elements 

who help to define the project context. Grids, levels and reference planes are 

examples of these kinds of elements. The last group are the view-specific 

elements.  They are only displayed in the views in which you place them, hence 

the name. Annotations, such as tags and dimensions are examples of these 

kinds of elements.  

 

 

Figure 5-24 - Hierarchy overview (source: Autodesk) 

 

All these elements answer to a certain hierarchy of Categories, Families, Types 

and Instances. This is best explained by an example. If we select an element in 

the project environment, like for example a column, we can see this hierarchy 

by hovering over the element. In this case, the selected column is an instance of 

the UC305x305x97 Type column, which is part of the UC-Universal Columns 

Family. This family is part of the Structural Columns Category. The power of this 

system is, that when you change certain properties of a type of a family, all 

instances of this type change accordingly in the whole project. That way you 

don’t have to change every instance individually, which will save you a lot of 

time.  
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Figure 5-25 – Instance of a column 

 Families 5.2.2.3

The concept of a family is very important in Revit. On the Autodesk Help website 

we can find a good definition: “A family is a group of elements with a common 

set of properties, called parameters, and a related graphical representation.” So 

everything we draw in 2D or 3D, is in some way related to this concept of 

families. There are 3 major kinds of families: you have the ‘System Families’, 

the ‘Loadable or Component Families’ and the ‘In-place Families’. 

1. System Families 

System Families are hardwired in the project environment of Revit. You add 

parameters, layers, materials to a certain system family, and they are bound to 

certain rules which are predefined in the software. You can’t load them, nor 

save them externally. These are typically basic elements that you assemble on 

the building site itself of an actual building project. Examples of a system family 

are for example walls, roofs and floors. These kind of families are often 

quantified in terms of length, surface or volume. 

2. Loadable Families 

Loadable Families, also sometimes called component-families, are another 

major kind of family. These you don’t create in the project environment, but in 

the Family Editor environment. These are typically elements that are installed in 

the building, based on the carcass of the building. They are often counted as 

individual objects. You could see them as more self-contained and less 

dependent on other geometry. Doors, windows, furniture and plumbing-fixtures 

are great examples of loadable component families. Also 2D-components you 

use for making sheets, such as symbols like a north arrow or title-blocks, are 

loadable families. However, these are part of the Annotation Family instead of 

the Component Family.  You can recognize Loadable Families by their *.rfa 

extension. When people speak about families in general in Revit, they often 

mean a loadable or component family. 
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3. In-place Families 

The last kind is an In-place Family. These are created in the project-

environment itself, with many of the basic tools you find in the Revit Family 

Editor. The shape of an In-place Family and form are heavily based and 

referenced to other project geometry. This means they are almost impossible to 

export or copy, since they are so dependent on actual project-geometry. This 

kind of family you can, for example, use when you want to create a desk 

element that is supported by a uniquely shaped column in the project. When the 

column is located somewhere else or form changes, the desk will adjust 

accordingly. 

5.3 General settings 

5.3.1 Working units 

There are a few importing things to customize before we start drawing. As we 

want to draw our model following the COBIM rules as much as possible, the first 

task was to set our working units to millimeter. 

 ArchiCAD 5.3.1.1

To edit the working units in ArchiCAD, you go to the Menu Bar, select Options > 

Project Preferences > Working Units 5-26. In the Working Units Settings Dialog 

5-27, we select millimeter as our working unit.  

 

 Figure 5-26 - Navigating to Working Units          Figure 5-27 - Working Units Dialog 
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 Revit 5.3.1.2

To edit the working units in Revit, you go to the Manage-tab on the Ribbon > 

Settings Panel > Project Units and adjust the settings accordingly. 

 

Figure 5-28 - Project Units Dialog 

5.3.2 Project location 

Specifying the project location and orientation is crucial to calculate the right 

position of the sun in our 3D-environment. The position of the sun is important 

in situations like 3D views, camera views, photo renderings and sun studies.  

To specify the latitude and longitude of the building, the easiest way is to go to 

the building location on Google Maps. If you left click at the position of the 

building in google maps 5-31A, the exact latitude and longitude will appear on 

the top left 5-31B of your screen. Also were the north is situated, can be 

derived from Google Maps.  

 ArchiCAD 5.3.2.1

To edit the location of the project, you 

have to go to the Menu Bar, select 

Options > Project Preferences > Project 

Location 5-29. In the Project Location 

Settings Dialog 5-30, we begin by 

adding the Project Name and the Site 

Address. When clicking on the edit 

button 5-30A, a structured dialog will 

pop up so you can add the Project Name 

and Site Address. 

You can just copy and paste the 

numbers you get from Google Maps into 

the latitude and longitude box 5-30B. 

You can control the location by clicking 

on ‘Show in Google Maps’ 5-30C. This 

button will direct you automatically to 
 Figure  5-29 - Navigating to Project Location 
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Google Maps, based on the numbers you filled in for latitude and longitude. 

We can define the North in 2 ways. The first option is to fill in a specific angle. 

The second option is to move your mouse above the icon 5-30D and move the 

pointer towards the north. 

   

Figure 5-30 - Project Location Settings Dialog   Figure 5-31 - Location of the building    

 Revit 5.3.2.2

To access the location parameters, you go to the Project Panel on the Manage 

Tab > Location. Like in ArchiCAD, we looked up the exact coordinates on Google 

Maps. To change the orientation of the building, go to the Manage Tab > Project 

Location panel > Position. 

 

Figure 5-32 - Location Settings dialog 

5.3.3 Importing the original plans 

In order to be able to draw the model, we needed to have consistent plans of 

the building. Initially we got some AutoCAD-plans from the City of Seinäjoki. 

These plans were drawn for administrative purposes, to locate all the different 

spaces and their surface-area. However, the plans had not enough consistency 

to serve as a base for our project.   
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Figure 5-33 – Inconsistent AutoCAD-plans 

 

There was also the possibility to get the original plans drawn by Alvar Aalto 

himself. Both the City and the Alvar Aalto Foundation were contacted, and we 

were able to get the scans of the original plans. The Plans of the Alvar Aalto 

Foundation were a little bit different from the ones from the city. Because the 

plans from the Alvar Aalto Foundation had very detailed written dimensions, we 

decided to use these as our main source of information. 

 

Figure 5-34 - Original plan of the ground floor 

 

In order to be able to work fast and efficient, we decided to import the plans 

into the software. We used the plan as an underlay, so we didn’t need to go 

back and forth between the software and the pictures of the plans. We also got 

the plans on paper, but these were too big to constantly work with. The paper 

plans were helpful in situations where dimensions were missing, so we could still 

measure the distance on the paper plans. You can find all the original plans in 

appendix 3. 
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 ArchiCAD 5.3.3.1

The easiest way to import the plans, is just to drag the file from the location you 

stored it 5-35A and drop it into the ArchiCAD drawing area 5-35B.  

In our case, the plans were JPG-files. But it is also possible to import all kinds of 

other file types. The most important formats are PDF, DWG, DXF, PNG and IFC 

 

Figure 5-35 - Drag and dropping the file into the project (in ArchiCAD) 

 Revit 5.3.3.2

You can use the same procedure as in ArchiCAD by dragging the file into the 

project browser. However, in contrast with ArchiCAD, you cannot drag PDF-files 

directly into Revit. Although this was not an issue in our project, this is quite a 

handicap. There is a work-around however, by converting your PDF to an 

image-file with a convertor. Not being able to drag PDF’s directly felt strange, 

since this file type is a widely used format. 

5.3.4 Scaling and rotating the plan 

 General 5.3.4.1

Once we have imported the plans into the appropriate floors (the topic of 

making new floors is handled later), we need to rotate and scale the plans. This 

way we can define the location of the walls on the plans in an exact manner. 

First, we searched for a long line with a known dimension on the original plan. 

The longer the line, the more exact the scaling is going to be. Then we can 

rescale the image with the scale tool. In both software packages, this is done 

quite similar. Rotating is also quite easy to do. 
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Figure 5-36 - Rotating the plans (in ArchiCAD) 

 

Once we have decided which dimension to use as our reference, we select the 

image and go to Edit > Reshape > Resize 5-37. You can resize either by giving 

a scale-ratio or by defining it graphically. We decided to go with the latter. You 

select both points of the existing line and enter the desired length. The image 

will then scale appropriately.  

 

Figure 5-37 - Navigating to Resize 

 

Rotating is also easy to do. To rotate the file you have to go to the Menu Bar, 

select Edit > Move > Rotate. Another way is to just right click on the selected 

image and select Move > Rotate. Then you will be able to rotate the image. You 

can rotate the image to any angle you want, additionally the software will give 

hints when you are at 0, 90, 270 or 360°. 

 Revit 5.3.4.2

When you select the image, the modify tab will become active in the Ribbon. 

There you can activate the Scale (SE) and Rotate (RO) commands. Scaling is 

done similarly as in ArchiCAD. You pick two points of the line you want to 

rescale while the scale-command is activated. Then you type in the desired 

length and the image will scale appropriately. Also rotating is almost the same 

as in ArchiCAD, with the difference that you have to override point-snapping by 

typing ‘SO’ (snaps off) while you are in the rotate command. Otherwise you will 

always automatically snap to increments of 90° when you want to trace over the 

initial line on the image. 
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Figure 5-39 - Navigating to Grid System 

5.3.5 Setting up the grid element 

 General 5.3.5.1

As there was no grid drawn on any of the plans, the first step for us was figuring 

out a logic grid that would make drawing easier. We have to admit that this was 

not an easy job. Initially we based our Grid system on both the boundaries of 

some concrete walls as on the centerline of the columns. After some trial and 

error, we decided to just base our gridline on the columns of the first floor. One 

of the purposes of a gridline is to make the plan a little bit more logic and 

readable. We changed the grid at least 3 times to finally get the most efficient 

and best one. We decided to identify the horizontal gridlines with letters, 

starting from the bottom. The vertical gridlines are identified by numbers. 

In ArchiCAD it is possible to the place a Grid System. This means that all the 

gridlines will be placed at one time. It is also possible to draw them separately if 

you need custom shapes, like for example a curved gridline. In our case all the 

gridlines are straight, so we were able to place the grid with a Grid System.  

In Revit, it is not possible to place a grid system. So you have to draw each line 

separately, either by sketching and moving it to the right place or by offsetting 

it from the previous one. 

 ArchiCAD 5.3.5.2

In Archicad, you create your grid by going to the Menu Bar > Design > Grid 

System 5-39. The Grid Element Settings Dialog will open 5-38. All the 

settings are separated into 4 groups: General Settings, Grid Elements, Naming 

Rules and Grid Positions. The things you can define under General Settings are 

the geometry of the grid, which can be orthogonal or radial. It is also possible to 

place columns immediately together with your grid system and show dimensions 

between the gridlines on the 2D views. Under Grid Elements, you can define the 

position of the grid-tags and the point of input of the grid. In the Naming Rules-

dropdown you can set up the naming of the gridlines. 

      

 Figure  5-38 - Grid System Settings Dialog 

www.iiB
IM

so
lut

ion
s.i

r



46 

  
Figure 5-41 - Finalized grid for the State Office Building (Revit) 

 

Figure 5-40 - Placing the grid 

 

However, the ‘Grid positions’ is the most important setting 5-38. You can add 

or remove grid lines by clicking on the plus and minus signs 5-38A. When you 

have added the required gridlines, the next thing to do is defining the distances 

between the gridlines. You will have to fill in the distance between the selected 

gridline and the previous one, not the distance relative to the starting/first 

gridline.  

A ‘ghost’ grid system will show up and now we can place the grid system by left 

clicking in the drawing area 5-40A. ArchiCAD will now ask to click a second 

time to define the final position. This second click will determine the rotation of 

the grid system. In our case, the angle is 0°, so we can just enter this in the 

‘distance and angle box’ that pops up 5-40B or drag our cursor horizontal to 

the right 5-40C and click on a random distance. 

 Revit 5.3.5.3

In Revit you have to draw each Grid Line individually. This can be done in 

different ways. When in plan view, activate the Grid command by going to the 

Datum-panel in the Architecture tab and select the Grid-command. 

Alternatively, you can use the short-key ‘GR’. The first grid is drawn on-screen 

in the Drawing Area. We place the next grid by using an offset from the first 

gridline, with the ‘pick lines’ command in the Draw-panel. You will see that Revit 

numbers the grids automatically. When we start drawing the horizontal 

gridlines, we don’t need numbers anymore but letters. You just have to adjust 

the number to a letter, to A in our case, and Revit will automatically number the 

rest of our horizontal grids to B, C, D, etc., while you draw them. 
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5.3.6 Stories 

 General 5.3.6.1

The building has 3 stories above ground level and 1 story beneath ground level. 

However, we will need to create 5 stories because we also need a story for the 

roof. This is for example necessary to place the skylight domes. 

The story levels on the old plans are shown relative to the sea level (e.g. 

+45,000). We also wanted to do this in our model because it would be easier for 

us to work with. We changed the elevation-values to millimeter, since 

everything in our project is in this unit. 

 ArchiCAD 5.3.6.2

In ArchiCAD, all the stories are displayed in the Navigator’s Project Map. You 

can open a story by double clicking on them. You can also open and switch 

between the stories by using the Mini Navigator, which we already explained 

earlier (see 5.2.1.7).  

ArchiCAD automatically creates 3 stories in every new project. So we could use 

these stories and add 2 extra. To edit the stories settings, you have to go to the 

Menu Bar, select Design > Story Settings 5-43.  Another option is to right click 

at one of the stories in the Navigator Project Map and select Story Settings. 

When the Story Settings dialog opens, you add 2 extra stories by clicking on the 

‘insert below’ or ‘insert above’ button 5-42A.  

1. Trial and error 

The first time we created stories, we just imported the (high) values of the 

original plans. After defining the names of the stories, we started to fill in the 

elevation of the floors. But while doing this, it was not possible to give the 

basement with numbering -1 a positive elevation. This was a problem. Later in 

the project, we realized that we did not use the proper manner for importing 

these numbers. In the next paragraph, we will explain how we should have done 

it. Back in the beginning, we fixed this issue by deleting the story with 

numbering -1 and we numbered the basement 0 instead 5-42B. ‘The Height to 

Next’ will automatically update by filling in the ‘Elevation’ and it does the same 

when we do it the other way around. 

         

Figure 5-43 - Navigating to Story Settings Figure 5-42 - Story Settings Dialog 
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2. How we should have done it 

The previous way is not the proper manner for 

importing these numbers. In ArchiCAD, your ground 

floor elevation should be 0. It is also more logic if the 

basement has -1 as number. When the model was 

almost finished, we found the right way to do this. We 

changed the numbering of the basement to -1. The 

next thing we did, was editing the elevation-values. 

The ground floor starts with an elevation of 0 and the 

elevations of the other stories should be related to the 

ground floor and not to the sea level. After this, the 

settings are like shown in the figure below 5-46.   

The next thing we did, was defining the altitude 

between the ground floor and sea level, which is in our 

case is 46,4 meter. We defined this in the Project 

Location Settings (see 5.3.2.1). The Altitude box is 

located under the latitude and longitude settings. The 

last thing we did is navigating to one of our elevations 

or sections. When the elevation or section is opened, 

you right click at a blank space in the area and select 

Section Settings. The Section Settings Dialog will now 

open and we opened the group Story Levels 5-45A. 

Now we can change the reference level from project 

zero to sea level 5-45B. When clicking OK, the Level 

Points will automatic change 5-45C. You will have 

to do this in every section and elevation, as the 

settings will only be changed for the opened view. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5-44 - Final elevation settings 

Figure 5-46 - The right story settings Figure 5-45 - Changing the reference level 
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 Revit 5.3.6.3

In Revit, you add floors by going to an elevation view in the Project Browser. 

Once in an elevation view, you are able to add Levels. So when in elevation 

view, go to the Architecture Tab > Datum panel > Level. The standard short key 

is [LL]. Then you can just start sketching a Level. Once placed, you can change 

the name and elevation-height. Again, you can use the ‘pick lines’ –command 

and enter an offset for the other elevations. Later on, when the project 

progresses, it is easy to add additional elevations. We added 5 main Elevations, 

being Basement, Ground floor, First Floor, Second floor and Roof. Besides our 

main floors, we have added additional sub levels on the basement and ground 

floor. On these floors, there are alterations in the elevation of the floor slabs. By 

adding these extra elevations, we could just draw our floors in these elevations, 

preventing many offsets. 

When you select a specific level in Elevation view, tick-boxes on both sides will 

appear. These tick-boxes control the visibility of the text-tags. It can be 

convenient to be selective in the text you want to display. This way you can 

keep things organized.  

 

Figure 5-47 - Main levels and Sub levels 
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5.4 Setting up the materials 

5.4.1 Building materials 

 General 5.4.1.1

By default ArchiCAD and Revit already have a large amount of basic building 

materials in their libraries. However, these materials may not be enough or they 

need adjustments. Editing and making new material will be explained below. In 

both software packages, you can start with a full blank dialog or start from an 

already existing material. This can be useful when the new building material you 

want to create only needs a few adjustments compared to an existing material.  

How the material appears into section, floor plan and as a rendered image are 

examples of the changes you can apply. In addition, the physical properties, 

something that can be used to do simulations on the building, is adjustable in 

both Revit and ArchiCAD. 

 ArchiCAD 5.4.1.2

The Building Material Settings Dialog can be opened by going to the Menu Bar, 

selecting Options > Element Attributes > Building Materials. At the bottom of 

the dialog, you can create a new building material 5-48A or delete one 5-48B.  

When selecting a material on the left side of the Building Material Dialog, you 

can see the settings of the selected material on the right side. We can edit the 

name of the material at the top 5-48C. The next thing we come across, is the 

‘fill’ of the material 5-48D. The fill will define how the material is displayed in 

the 2D views. When clicking on the fill button a screen will pop-up. Here you can 

choose one of the fill types. It is also possible to create a new fill, when the one 

you require cannot be found in the library. Straight under the fill settings, we 

can define the surface of the material 5-48E. This will define how the material 

will look in 3D view and in photo renderings. You can also create your own 

surface. 

The Intersection Priority 5-48F is one of the most important things to set up 

for a building material. We will explain this more in detail later on in this chapter 

(see 5.4.3.2).  

Finally, we have the Tags and Categories group 5-48G, where details of the 

material can be filled in. Things like the thermal conductivity, density and heat 

capacity of the material can be added here. We could not define any of these, as 

we knew almost nothing about the used materials. 
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Figure 5-49 - Material Browser 

 

Figure 5-48 - Building Materials Settings Dialog 

 Revit 5.4.1.3

In Revit, you have a Material Browser [5-49] where you can add materials to 

the current project. You can find the browser on the Manage tab > Material 

Browser. Out of the box, Revit already offers many standard materials. These 

have certain properties, which are defined in the right pane, called the Material 

Editor [5-49A]. Here we find 5 tabs:  

 Identity: Here you add descriptions and product information. 

 Graphics: This controls the appearance of the materials in non-rendered 

views. 

 Appearance: This controls the appearance of the materials in rendered 

views and realistic views. 

 Physical: These are the properties used for analyzing structural 

properties. 

 Thermal: These are the properties used for energy-analysis. 
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5.4.2 Composite or compound structures 

 General 5.4.2.1

We will need more then only basic concrete or brick walls. Most of the time, 

walls consists of more than one layer. Drawing every different material of the 

wall separately can mean a lot of work. Therefore we need to create Composite 

(ArchiCAD) or Compound (Revit) Structures, where all the needed materials are 

combined into one wall. To explain the creating of a composite or compound 

structure, we will create one for the outer walls of the State Offices Building as 

an example. This wall consists of a concrete structure, with insulation and a 

brick/plaster finish. 

 

Figure 5-50 - Outer wall on ground floor level 

 

We decided to use a naming structure for our composites to keep things 

organized. The thickness of the wall-components is defined in millimeters and 

the naming starts with the exterior material. In this case the full name of the 

composite is therefore “GROUND 15-130-110-170” 5-51B. Just as with the 

Building Materials, duplicating an already existing structure can be very 

convenient when only a few things need to be edited. This is also possible in 

both software packages. 

 ArchiCAD 5.4.2.2

We start by creating a new composite structure 5-51A. A screen will pop up 

where we have to define the name of our structure.  By default, the new created 

composite structure consists of a brick wall with a thickness of 100mm 5-51. 

We will start by inserting 3 extra ‘skins’ 5-51C. All the added skins are brick 

walls with a thickness of 100mm, so we will need to adjust the material and 

thickness. When you click on the current selected material 5-51D, a screen will 

pop up with all the available building materials. We will define the top listed 

material as the exterior side and the bottom listed as the inner side. 

 

Figure 5-51 - Composite Structures Dialog 
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Figure 5-53 - Type Properties 

The next thing you can define, is the linetype and the colour of the skins. We 

will just keep these on the default settings 5-51E. The following thing to do, is 

defining the type of the material, which can be Core, Finish and Other 5-51F. 

This is an important setting when we finally start drawing the wall. This will be 

explained together with the Wall Tool (see 5.5.3.2). Another function, when you 

defined the type of material correctly, lies in the 3D-view. You can choose to 

only display the core structures for example. We will set the concrete as Core, 

the insulation and brick as Other and the plaster as Finish. 

Finally we can define the thickness of every material 5-51G and at the right 

bottom of the dialog we can define in which tool this composite structure can be 

used. The 4 options are the Wall Tool, Slab Tool, Roof Tool and Shell Tool 5-

51H. In the figure below, you can see the final result 5-52. 

 

Figure 5-52 - Final result of the created Composite Structure 

 Revit 5.4.2.3

When you activate the wall command on the architecture Tab, the properties-

palette will become active and you can click on ‘Edit Type’. This will bring up the 

Type Properties Dialog Box. Under construction, you can click on the Edit 

structure button. This brings up the Edit Assembly box. The floor and roof-

assemblies are changed in a similar way. 
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You can insert layers by pressing ‘Insert’ 5-54A, and then organizing them with 

the ‘Up and Down’ buttons 5-54B. A Material 5-54C and Thickness 5-54D 

can be set for each layer by clicking on them. When appointing a new material, 

Revit will bring up the Material Browser, where all your materials are stored. 

Layer 1 is located near the Exterior side 5-54F, and the next layers go inwards. 

The Function 5-54E of the materials and or if they are located in the Core 

Boundary 5-54G, are also important features. This will be explained in the next 

paragraph (see 5.4.3).  

 

Figure 5-54 - Edit Assembly 

 

In the ‘Default Wrapping’ section of the Edit Assembly dialog, you can choose if 

the wall has to wrap at either the end or/and at intersections (for example 

windows). For example, in wall A, the wrapping at inserts and ends is turned off. 

In wall B, the plasterwork wraps inwards at the windows and there is also a 

wrap at the end of the wall. 

 

Figure 5-55 – Different wrapping behavior 
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5.4.3 Intersection principles 

 General 5.4.3.1

How the different materials of the building components interact with each other, 

is in both software packages very important. The joints between different 

building components, like for example a wall and a floor, need to intersect and 

join as logical as possible. Although this is not a completely automated process, 

Revit and ArchiCAD provide some tools to make this process easier.   

In ArchiCAD, the intersection principle is based on the ‘Priority Settings’ of the 

material. Revit works with 5 functions you can assign to layers. There is also a 

‘Core Boundary’ in each wall, which has some additional properties. 

 ArchiCAD 5.4.3.2

In ArchiCAD, connections between all kinds of structural elements are based on 

the priority of the building material. The principle of the intersection of building 

materials based on priority is shown in the figure below 5-56. You can change 

the priority of a building material by opening the Building Material Dialog (see 

5.4.1.2). The priority of a material can be any number between 0 and 999, 

starting from 0 as the weakest priority. There are 2 ways to change the priority 

of the selected material. You can use the slider or fill in a number to adjust the 

priority 5-57.  

  

 Figure 5-56 - Intersection Principle  Figure 5-57 - Intersection Priority 

 

However, not all structures will intersect based on the priority settings of the 

building materials. The table below gives a clear view on which intersection-

principles are used on different elements.  
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Table 5-2 - Intersection-principles of the elements 

 Wall Beam Column Slab Roof Shell Morph 

Wall        

Beam        

Column        

Slab        

Roof        

Shell        

Morph        

 

 Automatic intersection based on the priority of the building material 

 Intersection based on the priority of the building material but requires trim/merge 

 No priority support 

 

 Revit 5.4.3.3

Joins and intersections of materials are determined by some specific principles. 

Like mentioned previously, you have to assign a ‘function’ to each layer of the 

compound wall. Which function is assigned to your layer, will determine how it 

will behave in relation with other layers. You have 6 possible Functions. 

Structure [1] has the highest priority, while Finish 2 [5] has the lowest. 

 Structure [1]: This is the layer that supports walls, floors and roofs. 

 Substrate [2]: Material that serves as an underlay/basis for another 

material, such as for example plywood. 

 Thermal/Air Layer [3]: Air and Insulation-materials are typically assigned 

to this layer.  

 Membrane Layer: A material that serves as a barrier for Vapour/water 

infiltration. This layer has to have a thickness of zero.  

 Finish 1 [4]: Finish material, typically on the exterior part.  

 Finish 2 [5]: Finish material, typically on the interior part.  

Layers with the same function will try to connect. And if these layers have the 

same material assigned to them, they will merge together. If they have different 

materials, a line will be used as graphical separation. When trying to connect, 

layers with a higher priority-function (meaning lower number) will cut through 

layers with a lower-priority function. 

In every compound element, you have a section that is called ‘Core’. You can 

assign layers to this core, and they will have extra intersection properties.  For 

example, the cores of 2 different compound structures will automatically join. In 

addition, layers with a low priority inside of a core can cut through high priority 

layers that are outside of a core. In Revit, you always have to have a layer 

inside your core-boundary. 
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Figure 5-59 - Wall-column relation 

 
Figure 5-58 - Priority and intersection (source: Autodesk) 

5.5 Carcass 

5.5.1 Columns 

 General 5.5.1.1

The placement of the columns was quite important, because most of the time 

the positioning of the walls was determined by the edges or the centerline of 

those columns [5-59]. When we first examined the old plans, we were quite 

confused. No dimensions of the columns were given. Also the shape of the 

columns could vary a lot. Sometimes we were able to derive the dimensions by 

adding up different dimensions of different floor plans. But most of the time, 

even this was not possible. Then there was another problem. When we 

measured the columns on the plans, they would not correspond with the actual 

dimensions on site. Also the shapes and sizes of columns, that logically 

supposed to be the same, differed once in a while. Trial and error was our part, 

and it took quite a long time to have some kind of column-system in place. 
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 ArchiCAD 5.5.1.2

We start by selecting the Column Tool from the Toolbox. You can adjust the 

settings from the Settings Dialog as well as from the Info Box. However, the 

Info Box is most used and helpful when you edit some small settings like the 

material or height from an element. Defining a large amount of settings is easier 

and faster from the Settings Dialog. We can open the Column Settings Dialog by 

double clicking on the Columns Tool in the Toolbox 5-60A. The Column Setting 

Dialog can also be accessed by clicking on the column symbol located at the left 

side of the Info Box 5-60B. These 2 ways of opening the Settings Dialog is the 

same for all the other tools as well. 

 

Figure 5-60 - Opening a Settings Dialog 

 

When opening the Settings Dialog, you can see that it is divided into 5 groups 

5-61. We will focus on the Geometry and Positioning group, as this is the most 

important one.  

You can link the bottom and top of the column to the stories you created 5-

61A. It is not mandatory to link it to a story, it is also possible to define the 

height of the column by yourself 5-61B. Optionally, you can define an offset for 

the column 5-61C. This can only be done when the column is linked to a story. 

The offset can be positive, negative or just zero. Another possibility to locate the 

home story of the column is also available in this group 5.61-D. With this tool, 

it is possible to define the distance relative to project zero, sea level, current 

story or other reference levels.  

On the right side of the Settings Dialog, you can define the measurements and 

shape of the column. It is possible to select a rectangular, circular or complex 

shaped column 5-61E. With the ‘complex profile’-tool, it is possible to draw any 

form of column that you want. In this project, we used all 3 shapes of columns. 

The use of complex profiles will be explained further on (see 5.8). The next 

thing we can define is the length and width of the column 5-61F. When we 

activate the link icon on the right, we say that the length and width of the 

column are the same. Right under this tool, you find the option to choose the 

material of the column 5-61G. When clicking on this window, a screen will 

open where you can choose one of the building materials from the library. 

With the ‘veneer’ option, the column can be surrounded by another material 5-

61H. You can choose the material and thickness of the veneer. You can also 

choose your column to be vertical or slanted 5-61I. We can fill in the angle 

when a slanted columns needs to be drawn. In this project, we only need 

vertical columns. The wrapping method can be selected, should the columns 

intersect with a composite wall 5-61J. Next to this setting, you can define the 

positioning angle of our column 5-61K. The rotation of the column can be 

defined before placing, but it is also possible to rotate the column after 

placement. The last setting we can define, is the anchor point of our column 5-
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61L. Most of the time, we selected the middle point of the column as the anchor 

point, as most of the gridlines intersect the columns in the middle. Once a 

column is placed, you can move it by dragging one of the many other available 

anchor points.  

 

Figure 5-61 - Column Settings Dialog 

 Revit 5.5.1.3

1. Architectural vs Structural Column 

There are 2 kinds of columns you can use in Revit. First we have the 

architectural column, which is situated under the Architecture tab > Column. 

The other kind is the structural column, which you can find both in the 

Architecture as Structure part of Revit. The first kind is a purely esthetic 

component due to its properties. You can place this kind of column if you just 

want non-bearing, esthetic pillar. You can also use it to ‘cover up’ the actual 

load-bearing structural columns. The architectural column is able to inherit the 

materials to which they are joined. Moreover, compound layers of neighboring 

elements can wrap around this kind of column. The other kind, is the structural 

column. The structural column is the one we have used for our State Offices 

Building. The reason why we used this one, is because a beam-structure only 

can ‘connect’ to structural columns, not the architectural ones. Structural 

columns can for example be used to perform load-bearing calculations by the 

engineer. The intended workflow for using these two kinds of columns would be 

as follows: The architect designs a building and ads architectural columns to his 

project. Then the project is handed over to the structural engineer, who can 

place structural columns ‘inside’ the existing architectural ones. Then he/she can 

start adding the structural framing, and use these to do his/her calculations. 
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2. Placing the columns 

For placing structural columns, we need to go to the Structure Tab > Columns. 

The first time you activate this command, a steel profile column will be loaded. 

For our project, we need rectangular and round concrete columns.  

 

Figure 5-62 – Columns 

 

When you click on load family [5-62A], the Revit Family’s Library opens. Be sure 

to go to structural columns, and not just columns. It can be confusing because 

‘columns’ are actually the architectural columns. We’re not sure why Autodesk 

didn’t just name them ‘architectural’ columns. 

When you have loaded the appropriate column-family, you can start making 

types. When a new type is made, you can start to place the columns in the 

drawing area on the appropriate floor. Every column drawn with this type of 

column, is an instance of this column. When you change the properties of this 

specific type, all the instances of this type will be modified accordingly. This 

principle of instance/type is used throughout the Revit-software and is 

applicable on any kind of family. For making a new family-type, go to the 

properties palette [5-63] > edit type [5-63A] > duplicate. After you have 

duplicated the column and have given it an appropriate name (e.g. 400x400), 

you have to adjust the width and the depth of the column. Only naming it 

400x400 doesn’t do the trick. Be sure to adjust the dimensions in the 

Dimensions-parameter section. 

You can place columns in a different amount of ways. You can for example 

select ‘At Grids’ [5-62B] in the ‘Multiple’-panel of the modify-tab. With this 

method, a column will be placed at the intersection of 2 selected-gridlines. If 

you already have architectural columns in place, you can simply add structural 

ones by clicking on the ‘At Columns’ [5-62C] button. You can also add columns 

in 3D if you want. But the Grid will not be shown in 3D-mode in Revit, so we 

couldn’t use this method.  

We have drawn the columns one by one, so we could get maximal control over 

the placement. You just ‘click’ were you want them, for example at an 

intersection of gridlines. The anchor point is typically in the middle of the 

column. 
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Figure 5-63 - Properties palette of a Concrete Round Column 

 

By default, structural columns will be drawn downwards from the floor you are 

working on. This can be changed, so the column will go upwards [5-64A]. The 

‘Base Level’ is typically the floor you are drawing in, while the ‘Top Level’ is the 

floor above. Offsetting can be done in the Properties Palette as well.   

 

Figure 5-64 – Place Structural Column 

5.5.2 Beams 

 General 5.5.2.1

We had the same problems with the beams as with the columns. No dimensions 

were mentioned. What made it even harder, was that none of the beams were 

displayed on the original floor plans, because these are architectural drawings. 

Because of this, we had to base ourselves on the 6 cross-sections we had. 

Taking measurements by ourselves on site was in most cases not possible, as 

most of the beams were covered by a false ceiling. What made things worse, 

was that we didn’t have a longitudinal section. So we had no clue of the 

longitudinal beams. So we had to do some improvisations there as well, placing 

beams as logical as possible. 

 ArchiCAD 5.5.2.2

You begin with selecting the Beam Tool from the Toolbox. When the Settings 

Dialog is opened, you can see that it is divided into 6 groups 5-65. We will 

focus again on the Geometry and Positioning group.  
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First, you can define the height of the beam 5-65A. Next, you can define the 

offset of the top of the beam to the selected Home Story 5-65B. By default, 

the Home Story will be the story that you’re currently working on. The offset 

can be positive as well as negative. As home story you can select one of the 

stories we created earlier 5-65C. Another possibility to locate the Home Story 

of the beam is also available in this group 5-65D. In this tool, it is possible to 

the define the distance relative to project zero, sea level, current story or other 

reference levels. 

On the right side of the Settings Dialog, you can define the thickness and shape 

of the beam. It is possible to select a rectangular or complex shaped beam 5-

65-E. Next to the defining the shape, you can fill in the width of the beam 5-

65F. The next option is choosing the material of the column 5-65G. A screen 

will pop up, where you can choose one of the building materials from the library. 

The next thing we can define, is if our beam has to be horizontal or inclined 5-

65H. An inclined beam will have an offset between the starting- and ending 

point of the beam. You can define the angle of the inclined beam right next to 

these 2 icons. The last setting of this group is defining the reference axis 5-

65I. By default the reference axis will be located at the middle of the beam. In 

some cases, it can be useful to use another reference axis.  

Just like with the Column Tool, the most important things that can be set up in 

the other 5 groups are the ways of displaying of the beams in 2D and 3D. 

However, the Beam Tool has an extra group. You can create holes in the beams 

5-65J, which can be useful if HVAC is also part of your model. It is possible to 

create rectangular and circular shaped holes. 

 

Figure 5-65 - Beam Settings Dialog 

 

When clicking the OK button, you can start placing the beams. In the Info Box 

you can select one of the geometry methods 5-66A. We can define 4 methods. 

Starting from the left we have the Single Beam. The name says it all, you just 

draw a beam by defining the start- and ending point with 2 clicks. Next to the 

Single Beam, we have the Chained Method. With this method you can draw a 

sequence of connected beams. The 3th option is the Rectangle Beam. With this 

tool you will be able to draw 4 beams with coincident nodes. Finally, you have 

the Curved Beam, which will make it possible to create curved beams. In our 

model we only used the Single Beam Method.  
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Figure 5-66 - Info Box of the Beam Tool 

 Revit 5.5.2.3

Placing beams in Revit proved to be quite a challenge. When you first load a 

new beam-family under the Structure-tab, you will have to go into the 

‘structural framing’ map of the library section. This proved to be a little bit 

confusing, because there was no mentioning of ‘beams’ in the map. So while 

you specifically start the command by pressing the ‘beam’ command, Autodesk 

suddenly stops mentioning it in the actual Library-map, naming it ‘structural 

framing’. 

Another thing that was a little bit confusing at first, is the way we are taught in 

school to look at beams on the plan. Normally, we look up from the floor we are 

standing on, to see the framework above our heads. So when we see a plan and 

there are beams drawn, we automatically assume they are above our heads.  

First of all, beams are (just like structural columns) drawn ‘downwards’, and are 

placed on the level below the view you are working in. This means, if you want 

to represent the beam-work in the basement for example (beams above your 

head in the basement), you draw by default on the ground floor. This can be 

changed by picking another placement plane 5-67A, before the actual drawing. 

 
Figure 5-67 – Option bar beam 

 

Also, when we first drew a beam, the beam was nowhere to be seen 5-68. This 

was because we were apparently drawing in an architectural drawing-template. 

 

Figure 5-68 – Warning when we tried to draw a beam in Revit 

 

So we had to play with the settings of our View-Range (properties for the 

cutting plane and ‘how far’ your eye can see). First, you have the Primary 

range. In this part we distinct Top 5-70A, Cut Plane 5-70B and Bottom 5-

70C. The region that is cut by the Cut Plane, will be represented in the ‘cut’ 

linotype. The Cut plane height can be changed by offsetting it relative to the 

floor plan you are in. The elements that are in the top-range (above the cutting 

plane) and bottom-range (below the cutting plane) will be displayed in the 

‘projection’ line type. The view depth is the zone beyond the bottom (if you are 

looking down, so in floor plan view) or beyond the top (if you are looking up, so 

in ceiling plan-view) of the primary range. Everything that’s in the view depth 

range, will be shown in ‘beyond’-line style. To access the View-Range Dialog, 

you go to the properties-palette 5-69 >Extents View Range > Edit. 
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Figure 5-69 – Properties of the ceiling plan 

 

 

           Figure 5-70 - View Range Box    Figure 5-71 - Representation of the View Ranges 

 

It was frustrating at the beginning, because there was no way we could see our 

beams in the floor plans. And it appeared we were not the only ones having this 

problem with representing beams in our floor plans. In the end, we used the 

ceiling-plan views to draw up our beams. While in a floorplan, a cut is made at a 

certain height, and you look down, in a ceiling plan a cut is made and you are 

looking up. This proofed to be ideal to place our structural framing. The 

approach of drawing beams is the same as with columns. You load in a family 

(Structural Framing > Concrete > Rectangular Beam). Then you make types of 

your beam-family and place them appropriately. 
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5.5.3 Walls 

 General 5.5.3.1

Something that made our work harder and slower is shown in the 

figure on the right 5-72. In this image, both walls are drawn 

with the same thickness, but have different dimensions. We 

decided to base the dimensions of our model as much as possible 

on the dimensions that are shown on the plans. This is how the 

actual builders back in the ‘60 would have used the plans. But a 

lot of dimensions were not shown on the plan, so would 

measuring elements be accurate enough if a wall of 20 cm is 

drawn with the same thickness as one of 15 cm? As much as 

these irregularities made our work slower and harder, we have to 

admit that these plans, all fully drawn by hand, have some kind 

of charm and made us realize how much work was put into the 

plans back into the days. A wall that was drawn in the wrong way 

was not editable in 10 seconds, like we are now used to do. 

Before the first line of a wall was drawn, everything needed 

to be thought off in advance.  

Another concern was that not every dimension was displayed on the floor plans, 

so sometimes we had to search hard and add/subtract a lot of dimensions to 

define the place of a wall. In some cases it was not possible to identify the right 

place of a wall at all, so in that case we had to rely ourselves on the underlay to 

position the wall as accurate as possible.  

 ArchiCAD 5.5.3.2

We start by selecting the Wall Tool from the Toolbox. When the settings dialog 

is opened, you can see that it is divided into 5 groups 5-73. Again, we will 

focus on the Geometry and Positioning group.  

To start, you can link the bottom and top of the wall to the stories you created 

5-73A. It is not mandatory to link it to a story, it is also possible to define the 

height of the wall yourself 5-73B. Optionally you can define an offset for the 

wall 5-73C. This can only be done when the wall is linked to a story. The offset 

can be positive, negative or just zero. Another possibility to locate the home 

story of the wall is also available in this group 5-73D. In this tool, it’s possible 

the define the distance relative to project zero, sea level, current story or other 

reference levels.  

On the right side of the Settings Dialog, you can define the structure of the wall 

5-73E. The first option is a Basic Wall, which exists of one material. The second 

option is a Composite Wall. In that case, you can choose to draw one of your 

earlier created composite structures. The last option is a Complex Profile, which 

we will use to detail our model. We’ll explain the functions and usage of this tool 

later on (see 5.8).  

After you have chosen the structure of the wall, you can select which building 

material, composite structure or complex profile you want your wall to be 5-

73F. When clicking on this, a screen will pop up with all the available options. 

Next, we can define our wall to be straight, trapezoid or polygonal 5-73G. In 

our model we only used a straight wall. Next to these options, we can define the 

thickness of our wall. When selecting a composite wall, it is not possible to 

define the thickness yourself. The thickness will be defined by the composite 

structure you created.  

 Figure 5-72 - Scale error 
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Figure 5-75 - Walls of the ground floor 

 

We can also define the complexity of the wall, which can be straight, slanted or 

double slanted 5-73H. Most of the time we used straight wall. Only when we 

needed to draw the structure for the skylights, we used a slanted wall.  

Just like with the Beam Tool, the last thing to set up is the reference line of our 

element 5-73I. ArchiCAD has 6 different reference lines: Outside, Inside, 

Center, Core outside, Core Inside and Core center 5-74. A wall existing of only 

one material has only the first 3 possibilities. The figure below gives a clear view 

on the principle of the reference lines. This shows up why it was important to 

set up the type of the material (Core, Finish, Other) when you create a 

Composite Structure. 

  

       Figure 5-73 - Wall Settings Dialog     Figure 5-74 - Wall reference lines 

 

When clicking the OK button, we can start placing our walls. In the Info Box we 

can select one of the Geometry Methods. We have 4 methods. Starting from the 

left we have the Straight Wall. The Straight Wall has another 4 options to 

choose from, which are the Single, Chained, Rectangular and Rotated 

Rectangular. They all work with the same principle as the ones from the Beam 

Tool. The 3 other Geometry Methods that can be selected are Curved, Trapezoid 

and Polygonal. Most of the time, we use the Single Straight geometry method. 
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 Basics of positioning in ArchiCAD  5.5.3.3

In this part we’ll explain the options to draw the wall in a situation like shown in 

the picture below 5-77. We can draw and define the position of the wall in 

different ways. During the project, we used all the 4 ways that are explained 

below. None of them can be defined as the best one. They all have advantages 

in different kinds of situations. To start, we will need the Control Box to be 

displayed. This can be done by going to the Menu Bar, selecting Window > 

Palettes > Control Box. 

 

Figure 5-76 - Control Box 

1. Using Guide Lines 

First you need to select the Guide Line Segment from the Control Box 5-76A. 

Next, you define the starting point 5-77A and ending point 5-77B of the 

Guide Line. You can define the end point on an exact distance by pressing the 

TAB-button on your keyboard and then fill in the desired distance, which is in 

this case 1500mm. The ending point of the Guide Line will be the starting point 

of our wall 5-77B. After you select the Wall Tool and define the starting point, 

you can drag your cursor down and easily define the ending point of our wall 5-

77C. The wall will automatically snap in a straight angle when you are holding it 

close to the 90 degrees point. Another option, to be sure that the wall is drawn 

straight, is holding down the SHIFT-button on your keyboard while defining the 

ending point. The wall will automatically snap onto the 0°-, 90°-, 180°- or 270°- 

points. The Guide Line, which is an orange dashed line, will disappear automatic 

after you have drawn the wall. 

 

Figure 5-77 - Placing wall using Guide Lines 
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2. Offset Constraint 

Another way to move your wall is by using the Offset Constraint. First, you have 

to click and hold the Relative Construction Methods icon from the Control Box 

5-76B. A small screen will pop up with 7 icons. Now you need to select the 

Offset Constraint icon, which is the fourth icon starting from the left. The next 

step is selecting the Wall Tool from the Tool Box. The first thing we need to do is 

drawing our wall by defining the starting- 5-78A and ending point 5-78B. The 

place where the wall is drawn will function as reference line, so it is the easiest 

to draw the wall on the already existing wall. When we defined the ending point 

of our wall, a slight dashed line will appear 5-78C. We can drag this line to the 

left or to the right. In our case we will need to drag it to the right and define the 

offset that the wall needs by pressing the TAB-button and filling in 1630mm 5-

78D. The only thing left to do is pressing the ENTER-button on your keyboard 

and the wall will be drawn on the right place. 

 

Figure 5-78 - Placing wall using Offset Constraint 

3. Move 

In this case, you need to select the Wall Tool from the Toolbox from the start. 

We will draw the wall on the already existing wall just like we did when we used 

the Offset Constraint. Next, you have to select the wall you have just drawn by 

left clicking on it. Now you can select the reference line of that wall, which is, in 

this situation, located on the left 5-79A. By clicking on the reference line, the 

Pet Palette will pop up. You need to choose the Move icon, which is the first one 

starting from the left 5-79B. Now you have to drag your cursor to the right in a 

horizontal line. The last thing that has to be done, is defining how far the wall 

needs to be moved, which is in this case (again) 1630mm 5-79C. End with a 

hit on the ENTER-button of your keyboard and the wall will be moved to the 

correct place. 

 

www.iiB
IM

so
lut

ion
s.i

r



69 

  

 

Figure 5-79 - Placing wall using Move 

4. Special Snap Point 

First we need to activate and set up the Special Snap Points, which is located 

in the Standard Bar 5-80. We can edit the settings by clicking on the small 

arrow next to the icon. If you then select ‘Set Special Snap Values’, you can 

define the settings that are needed in this situation 5-80D.  

There are three possible settings. The first one is ‘Divisions’. If you enter a 

value of ‘3’ for example, the snap points will pop up that will split the wall 

into three equal parts. The second option is Percent. Entering a value of 20 

will result in dividing the wall into 5 equal parts. Finally, we have Distance. 

By filling in a value of 500, a pop up snapping point will appear every 

500mm. The last thing we have to do before drawing the wall is selecting 

the ‘Distance’ 5-80B. Also ‘Between Intersection Points’ 5-80C has to be 

ticked. You can make these alterations in the ‘Special Snap Points Menu’. 

The ‘Between Intersection Points’- option controls if division starts from the 

inside 5-81A or from the outside 5-81B of the wall. 

     

Figure 5-80 - Special Snap Point Options      Figure 5-81 - Between Intersection Points 

 

First we have to select the Wall Tool and then we can start drawing our wall. 

You should start with moving your cursor on the wall where the starting point 

will be located. With moving your cursor over the wall, the snap points will pop 

up showing a point every 500mm 5-82A. Now we can select the starting point 

of our wall. In our case it is the third snapping point, since our wall is located 

1500mm from the reference wall 5-82B. The last thing to do is defining our 

ending point at the bottom just like we did before 5-82C. 
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Figure 5-82 - Placing wall using Special Snap Points 

 Revit 5.5.3.4

The Placement of the walls starts with the activation of the Wall-tool in the 

Revit-tab of the ribbon. On the dropdown of the Wall-icon, you have 3 

possibilities. You can either make an Architectural wall, a Structural Wall or a 

Wall by face. Again, the difference between non-structural (architectural) and 

structural, are the extra properties for the structural part. You can use structural 

for bearing walls, and architectural for non-bearing (filling) walls. The choice of 

structural or architectural is non–definitive, as you can change it afterward by 

ticking it on/off in the properties panel. For the wall by face command, you first 

need a mass object created in the massing environment. Massing-object are not 

utilized in this project. 

For the architectural and structural walls, you can choose between a basic wall 

5-83C, a stacked wall 5-83A and a curtain wall 5-83B. Basic walls can either 

consist of a single layer or multiple layers (=compound wall). A curtain wall is 

part of the exterior wall system but doesn’t have any load-bearing properties. 

They often have mullions, to separate and support glass or covering elements. 

Finally, a stacked wall is a wall that consists of separate vertical wall 

components. 

 

Figure 5-83 - Possible walls 
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For our purposes, we only need a basic wall. So we start duplicating an existing 

basic wall, so we can make a new type and edit the assembly [see 5-54]. We 

add layers to the wall, ad a function, adjust thickness and appoint materials. 

Our next step is to actually place the walls. 

 

Figure 5-84 – Options bar wall 

 

When the Wall command is activated, you can select the Base Constraint and 

Top Constraint in the option bar [5-84]. After placing the wall, you can adjust 

these settings in the Properties Palette. Here you can also change the offset 

values (Base and Top Offset). You also have to decide where your location line 

will be. This way you can control the point of input of your compound element. 

The possible location lines are identical to the Reference lines of ArchiCAD, but 

they just have a different name. The possible location lines are: Wall Centerline 

[5-85E], Core Centerline [5-85C], Core Face:Exterior [5-85D], Core 

Face:Interior [5-85B], Finish Face:Exterior [5-85F]  and Finish Face: Interior [5-

85A]. 

 

Figure 5-85 - Reference Lines 

 

You can draw a single wall or a series of chained walls, with the possibility of 

offsetting them. You can add an offset value in the Options Bar. You can also 

draw walls in a certain geometrical relation to each other, for example a 

rectangle, a circle, polygons or by spline [5-86] [5-87]. Another possibility is to 

first sketch a form with lines, and then appoint walls to those lines with the ‘Pick 

Lines’ tool [5-86A] in the Draw panel of the Modify-palette. 

      

    Figure 5-86 – Pick Lines Tool   Figure 5-87 – Different Wall forms  
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Figure  5-89 - Using the Aligned Dimension tool in the State Office Building 

In Revit, you don’t have to draw your element (e.g. a wall) immediately on the 

right spot (we even advise against it). You first sketch you element 

approximately in the right place and then you adjust. You have some powerful 

tools to move your wall to the appropriate location. When we had our underlay 

raster-image in place, we could simply start by tracing over with the appropriate 

wall-types. Then we used tools like Dimension, Align and Trim-extent to modify 

our wall-location. 

1. Dimension  

To activate the Aligned Dimension tool, you go to the Modify-tab > Measure 

Panel > Aligned Dimension. You can also access the command by using the 

shortkey ‘DI’. You simply place a dimension between two elements. The next 

step is to select the element you want to move. When you do, the dimension 

you just placed will become active. Then you can specify your displacement 

value, and the element will move accordingly [5-88]. You always select the 

element you want to move, the other one will stay on its original place. We 

literally used this command a thousand times, and we found it a joy to work 

with [5-89]. 

 

Figure 5-88 - Moving a column using the Aligned Dimension tool 
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Figure 5-91 - Walls of the basement 

2. Align 

The Align tool was probably the most used tool in our project. It will be familiar 

when you are used to the AutoCAD-software. You activate it by going to the 

modify tab. We always used the short key, typing AL. After starting the align-

command, you pick the face, line or point you want to align with, and then you 

pick the face, line or point to align. Selecting a particular point, line or face on a 

component is done with the TAB-key. Most of the times, multiple lines will be 

drawn over each other, and then it can be hard to instantly pick the one you 

want. You can just ‘cycle’ though all elements that are near your mouse-cursor 

by pressing the TAB-key. 

3. Trim Extent 

Another great feature we used extensively are the Trim Extent-tools in Revit. 

You can trim/extent to a corner (shortkey TR), trim extent to single (we 

appointed TS as short key) and trim extent to multiple (we appointed TM as 

short key). 

 

Figure 5-90 – Drawing walls with Pick Lines tool 

 

To give you a good example of how we tried to use the tools in Revit in the best 

way, we will show how we have drawn the basement wall. We first started with 

drawing the outlines of the basement-wall with model lines (Architecture-tab > 

Model panel > Model Line). We added dimensions, to control the drawn 

measurements and we adjusted if needed. Then we activated the wall-command 

and used the Pick Lines tool. We made sure our Location Line of the wall was set 

to ‘Finish face Exterior’ (or Core Face Exterior, since it is just a one-layered 

wall). Then we could select the whole chain of lines by cycling with TAB. Then 

we just had to click, and our basement-walls were born. 
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5.5.4 Slabs 

 General 5.5.4.1

The slabs would have been an easy and fast job if every floor only had one story 

level. Obviously, this was not the case. The State Office Building has different 

elevation levels in both basement and ground floor. The thickness of the 

concrete is also varying. For example, the bomb shelter ceiling has a thickness 

of 60cm. We also needed to draw ramps, to overcome these floor-variations. 

There are 2 smaller ramps in the basement and there is one bigger ramp on the 

outside. The big on makes it possible to drive a vehicle into the basement.  

 ArchiCAD 5.5.4.2

You start by selecting the Slab Tool from the Toolbox. In the settings dialog, you 

see 5 groups 5-92.  

First, you can define the thickness of the slab 5-92A. Right under this setting, 

you can define the offset of the slab relative to the Home Story 5-92B. The 

offset can be positive, negative or just zero. Next, you can define the Home 

Story of the slab 5-92C. Another possibility to locate the home story of the 

slab is also available in this group 5-92D. In this tool, it is possible to define 

the distance relative to project zero, sea level, current story or other reference 

levels. 

On the right side of the Settings Dialog, you can define the structure of the slab.  

This can be a Basic Slab, existing out of one material or a Composite Structure 

5-92E. Right under this setting, you can define the kind of Building Material or 

Composite Structure of the slab 5-92F. 

You can also give an angle to your slab. The slab is perpendicular by default, but 

you can give the slab an angle. To do this, you click on the right icon and fill in 

the angle 5-92G.  

The last setting defines the reference plane of the slab. Here you can set which 

reference functions as “zero” plane. When you define an offset, the offset will be 

given from that plane. When you select a Basic Slab you have 2 options, being 

top and bottom. When you select a Composite Structure, you have 4 options. 

These options are top, bottom, core top and core bottom. When selecting one of 

the 2 last reference planes, it is important to set the right materials as Core 

when you create the Composite Structure. 

Just like with the previous tools, the most important things that can be set up in 

the other 4 groups are the ways of displaying of the slab in 2D and 3D. 
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Figure 5-92 - Slab Settings Dialog 

 

 

Figure 5-93 - Slab of the basement (with ramps) 

 

Now you can start placing the slab. In the Info Box you can select one of the 

Geometry Methods 5-94A. We can define 3 methods. Starting from the left we 

have Polygonal. This one we used the most because you can define any shape of 

slab you want. The other two possible Geometry Methods are Rectangle and 

Rotated Rectangle.  

 

Figure 5-94 - Info Box of the Slab Tool 

 

In some cases it will be necessary to create an opening in the slab. For example 

were a stair is coming through the floor. First you need to select the slab in 

which you want to create the opening. Then you select the Slab Tool and start 

drawing the opening you want to have. ArchiCAD will interpret the new contour 

as a hole in the slab. 
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 Revit 5.5.4.3

You have 2 kinds of slabs or floors in Revit, which are the structural and the 

architectural floors. Like with beams, columns and walls, the structural walls 

have some extra properties and parameters. These parameters can be used for 

analyzing strength-properties and for calculating reinforcing bars. 

We will draw a floor by going to the Architecture tab > Floor. In the Floor 

command-dropdown, we select structural. Typically, the slabs are drawn 

downwards, just like structural columns and beams. When you first start the 

command, you will have to make a new type. The procedure of making floor-

types is very similar to that of making wall-types. You duplicate [5-95A] an 

existing type by going to the Edit Type Button [5-95B] on the properties palette. 

Then you can edit your assembly by adding layers, functions, materials and 

thickness [5-96]. 

 
 

Figure 5-95 - Type Properties of a floor 
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Figure 5-96 - Edit Assembly 

 

When you assembled your floor, you can start defining the boundaries. This can 

be done in different ways. We can use all the utilities of the Draw panel in the 

Modify Tab. You can just start sketching the lines, or pick individual lines of a 

wall. You also have the ability to pick walls. For an irregular form like our 

building, we used a combination of picking lines, picking walls and drawing 

individual lines.  

 

Figure 5-97 – Pick Walls 

 

In the end, you should have a closed loop, and no overlapping lines. Your sketch 

boundary will appear in pink.  
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Figure 5-98 – Setting the boundary of the floor 

 

You can use Trim/Extent to clean all your intersecting lines. When you use the 

‘Pick Walls’- tool, an extra setting will be available in the Options bar. You can 

choose to extent your floor to your core of your wall [5-99]. When working with 

a compound wall, this is a very simple tool to get your floor into the core of your 

walls and to join both structures.  

 

Figure 5-99 – Offset 

 

When you click ‘Finish Edit Mode’, sometimes you will be prompted with some 

extra questions: 

 

       Figure 5-100 – Attach walls to floor                Figure 5-101 – Cut/join overlap 

 

The first question will be about lowering your walls to the underside of your floor 

[5-100]. If you pick no, everything will stay on its place, so your walls will 

overlap with your floor. Initially, this is not really a problem. You can manually 

attach your walls to floors later on, but this can be time-consuming. You can 

also join floor and wall with the ‘Join tool’, so one of the 2 materials will be cut 

according to priority-level of the materials. If you pick yes, all the walls on the 

floor level will lower to the underside of the ceiling. This poses no problem for 

your interior walls. But also the outside walls will lower, leaving a gap in your 

façades [5-103]. To solve this, you have to pick the outer walls and activate the 

Detach Top/Base command [5-102] in the Modify tab. Now the walls will go 

back to their original position. The second question will be about joining 

overlapping volumes [5-101]. This question will be prompted when you 

extended your floors into the core of the walls. You can either click yes and 

join/cut automatically, or you can click no and do it manually later on. 
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Figure 5-102 - Modify Wall   Figure 5-103 - Gap in the facade 

 

Some floor-areas in the State Office Building differ in height. To draw these 

floors, we created extra elevation levels [5-104], so we could use them as work 

planes.  

 

Figure 5-104 - Extra elevation levels in the Project Browser 
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Figure 5-106 - Stair Settings Dialog 

 

5.5.5 Stairs 

 General 5.5.5.1

The last missing part of our carcass, are the stairs. The building has four 

staircases. All four staircases will give you the possibility to go to the ground 

floor and first floor. Only three of them will lead to the basement and second 

floor. The staircases are made out of concrete.  

 

Figure 5-105 - Stair on the floor plan 

 ArchiCAD 5.5.5.2

You start with selecting the Stair Tool from the Toolbox. This time you can only 

define a small part of the settings from the Info Box and Settings Dialog. 

Settings like the offset, home story, placing point, angle and mirroring still have 

to be done from the Settings Dialog. Just like with the previous tools, the most 

important things that can be set up in the other 5 groups, are the ways of 

displaying the stair in 2D and 3D. In this case you need to set up most of 

settings in the StairMaker. StairMaker makes it possible to create a fully new 

type of stair. The library already has a few stairs 5-106A, but in our case, we 

will need to create a total new one.  
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When you open the Settings Dialog, you can see that it is divided into 6 groups 

5-106. You have to select Create Stair from the Geometry and Positioning 

group 5-106B. A screen will pop up where you need to define the type of stair 

you want to create 5-107. In this project, we will need the U-return with 

landing 5-107A.  

  

Figure 5-107 - Stair Type     Figure 5-108 – StairMaker 

 

After this, another screen will pop up where you have to define all the settings 

of the stair. You will define most of the dimensions of the stair in the Geometry 

and Flight Settings group, which is the first group. Most of the parameters in 

this group can be locked by clicking the lock icon next to it. If you do not lock a 

parameter, adjustments of other parameters can cause StairMaker to 

automatically edit the unlocked values. If parameters need changing, StairMaker 

will skip locked parameters and look for the next value in the hierarchy.  

The first group is divided into 3 parts: Geometry Settings, Flight Settings and 

Tread Settings. In the part of Geometry Settings, you have to define the rise 

height, flight width, stair width, lower part length, upper part length and the 

length of the walking line 5-108A. In the part of Flight Settings, you have to 

define the number of risers on the lower and upper side, width of the landing 

and the lower and upper offset of the landing 5-108B. In the last part, you 

define the tread depth and height 5-108C. When we would design a stair for a 

future building, we could define the riser geometry settings 5-108D. It is easier 

and more comfortable to climb a stair when the sum of twice the riser and the 

run (2*riser + run) is within the range of 60 to 65 cm. We can define this in the 

settings and check if the stair meets these settings by clicking on Check Stair at 

the left bottom of the dialog 5-108E. At the right top of the dialog, a 2D view 

of the stairs will show with the settings you just set up 5-108F.  

In the second group of the dialog you can define the structure type, thickness of 

the stair and the used material 5-109. In the third group you can define more 

specific settings of the treads like the thickness, possible offset and material of 

the treads 5-110. In the fourth group you can define the settings for the 

railing. In the last 2 groups you can define the symbol settings and listing 

settings.  
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       Figure 5-109 - Structure Type     Figure 5-110 - Tread Settings 

 

When all the settings are filled in correctly, you can save the stair by clicking 

Save Stair at the bottom left of the dialog. This can be useful when you need 

the same stair again in this or another project. It is not mandatory to save the 

stair, so it is also possible to just close the StairMaker, by clicking the OK button 

at the bottom right, and place the stair. 

 

Figure 5-111 - 3D view of a staircase 

 Revit 5.5.5.3

1. Creating openings in the floor plate 

Before we can actually draw the stairs in between our floors, we have to make 

openings in these floors. A way to do this is by editing the floor and sketch an 

opening. When you draw a rectangle in the floor boundary, Revit will interpret 

this as an opening. Another way to make openings is with the Shaft tool. This 

tool you find on the Architecture Tab > Opening Panel > Shaft. With this 

command, you create a negative space that ‘eats’ away the floors, ceilings and 

roofs in between a certain pre-defined height, width and depth. For the width 
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Figure 5-113 - Stair Properties 

and height, we sketch a rectangle on the appropriate spot in plan view.  In the 

properties palette we adjust the height of the box by selecting begin and end 

level. We had to use both methods in the State Offices Building, because the 

openings of certain staircases vary on each floor. 

2. Stair tool 

Under the Architecture Tab > Circulation panel, you can find the Stair Tool. With 

this tool, you can draw a stair-element. This can be done with a pre-defined 

path, using the ‘stair by component’ tool (Straight Path, Full Step Spiral, Center-

Ends Spiral, L-shaped Winder and U-Shaped Winder). Another way to make 

stairs is by sketching your own path in Sketch-mode. For our purposes we will 

use the stair by component with straight path. The drawing of the stairs proved 

to be quite straightforward, although many little tweaks were necessary.  

When you activate the stair by components-command, you first have to load an 

appropriate stair from the Family Library. The family we used is the ‘Cast-In-

Place-Stair, Monolithic Stair’. We selected straight run. In the properties palette, 

you can add the Base Level 5-113A and Top Level 5-113B. Then we counted 

the amount of risers/steps on our floor plans. For some stairs, we had to go on 

site to count the actual amount of steps.  You can add the ‘Desired Number of 

Risers’ 5-113C in the Properties palette. 

 

 

 

 

Figure 5-112 – Create a stair in Revit 
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Then we started to draw. The stairs make a turn of 180°, with a landing in 

between. Revit handles this very well. You just have to draw your first part and 

second part of your stairs, and Revit will automatically make a landing in 

between these two stair-parts. 

 

 

 

 

 

 

 

 

 

Figure 5-114 - Stairs in 3D 

5.6 Windows and doors 

 General 5.6.1.1

Now that the carcass is completed, we can start placing our windows and doors. 

The windows in Finland are nothing like the ones in Belgium. The climate can be 

very harsh in winter with temperatures well below the freezing point. Because of 

this, the buildings need to be isolated very well. This attention to isolation can 

also be seen in the windows. All over Finland we find these double-sash windows 

5-115 with in between an airspace of several centimeters. We still see this kind 

of double profiled windows everywhere, in old buildings but also in new ones. 

We combine the windows and doors into one part as creating and placing both is 

based on the same principle for both software packages. In total, there are over 

150 window-parts and over 350 doors installed in the building. 

 

 

Figure 5-115 – Double-sash window of the State Office Building 
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 ArchiCAD 5.6.1.2

In ArchiCAD we can relate on an extensive library. We’ve been able to find this 

type of window under the name of Inside-Outside Historic Window.  

We start with selecting the Window/Door Tool from the Toolbox. Just as with the 

previous tools, you can define the settings from the Info Box and Settings 

Dialog. 

When the Settings Dialog is opened, you can see that the dialog is divided in a 

left and a right side. On the left side you can browse through the library and 

search for the type of window/door you need 5-116A. All the possible settings 

for the window/door will appear on the right side of the dialog 5-116B.  

Just like with the previous tools, the Settings Dialog is separated into groups. 

The first 2 are the most important groups. In the remaining groups, things like 

the view options in 2D and 3D can be adjusted. We decided to keep these 

settings on default values. 

To start, you can define the width 5-116C and height 5-116D of the 

window/door. The next thing to do, is to define the height of the window/door 

from the chosen reference point 5-116E. Most of the time, the reference point 

will be from the bottom of the story you are working on. However, also the top 

and bottom of the host wall can be selected as reference point. 

The following setting is the depth of the window/door reveal 5-116F. The final 

setting is the anchor point of the window/door 5-116G. In this part, you have 

to define if you rather want to have your input anchor point on the left, right or 

center of the window. For example, when windows are placed against a 

columns, you need a left or a right anchoring point. A preview of the 

window/door will be shown at the top right of the Settings Dialog 5-116H.  

 

         Figure 5-116 - Window Settings Dialog  Figure 5-117 - Parameter options 

 

Now we’ll proceed to the more detailed settings of the window/door 5-117. 

ArchiCAD has a large range of settings. You can see all the editable parameters 

in the picture above 5-117A. All these parameters can be specified in detail. As 

our knowledge on the windows/doors was rather small, we could not define a lot 

of parameters. The frame and sill settings were the most important things to set 

up. 
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Figure 5-119 - Window on site 

After you assigned the parameters, you can start placing the window/door. As 

you move the cursor over a wall, a preview of the opening will appear. The sun 

icon and thick line represents the outside of the window/door, so we always 

need to move our cursor towards the outside of the building. When we click, the 

window/door will be placed and you are not able anymore to move the 

window/door. The only thing left to do is defining the opening side of the 

window/door. This can be either left or right towards the inside or outside of the 

wall.  

 

Figure 5-118 - 3D view of a created window 

 Revit 5.6.1.3

The biggest part of windows and doors in Revit, is selecting the ones you want 

to use. If you have some very custom shaped windows for example, the best 

method is to make them yourself in the Family Editor. The editing or creating is 

the time-consuming part. Once you have a good and appropriate window family, 

the rest is straightforward. The actual making of the windows will be explained 

in the chapter of The family editor (see 5.7.3).  

There are 2 main window-families we had to create, being the double windows 

with glass [5-120] and the ‘cover’-parts [5-121] in between the windows. The 

covers are covering those parts where beams and walls are in front of the 

window. The covers are placed, so these walls and columns are not visible from 

the outside. 
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         Figure 5-120 – Finished window                             Figure 5-121 – Finished cover  

 

So once we have loaded the 2 window families into our project, we can start 

making types. In total, we had to make 50 types of windows, which was quite a 

job. All sizes were mentioned on the plans, so we could use them perfectly as 

underlay. Once we had made our types, we could simply place them into the 

host wall. We used the align tool to align windows against columns and covers.  

In the properties palette, we adjusted the sillheights [5-123A] to to the 

appropriate dimension. We could derive these heights from the different cross-

section-plans. Doors are done with the exact same principle. 

 

 

 

 

 

 
Figure 5-122 - Adding windows in floor plan 

 

  
        Figure 5-123 - Properties palette window 

5.7 Revit Families 

5.7.1 General 

The concept of a family is very important in Autodesk Revit. On the Autodesk 

Help website we can find a good definition: “A family is a group of elements with 

a common set of properties, called parameters, and a related graphical 

representation.” So everything we draw in 2D or 3D, is in some way related to 

this concept of families. There are different kinds of families, and we will go 

further into detail below. 

5.7.2 Kinds of families 

There are 3 major kinds of families: you have the system families, the loadable 

or component families and the in-place families.  
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 System Families 5.7.2.1

System families are hardwired in the project environment of Revit. You add 

parameters, layers, materials to a certain system family, and they are bound to 

certain rules which are predefined in the software. You cannot load them nor 

save them externally. These are typically basic elements, which you assemble 

on the building site itself. Examples of a system family are for example a walls, 

roofs and floors. These kinds of families are often quantified in terms of length, 

surface or volume. 

 Loadable families 5.7.2.2

Loadable families, also sometimes called component-families, are another major 

kind of family. These you do not create in the project environment, but in the 

Family editor environment. These are typically elements that are installed in the 

building, based on the carcass of the building and are often counted as 

individual objects. You could see them as more self-contained and less 

dependent on other geometry. Doors, windows, furniture and plumbing-fixtures 

are great examples of loadable component families. But also 2D-components 

you use for making sheets, such as symbols are loadable families. A north arrow 

or title-blocks are examples of these loadable families, but these are part of the 

annotation families instead of the component family. You can recognize loadable 

families by their *.rfa extension. When people speak about families in general in 

Revit, they often mean a loadable or component family. 

 In-place family 5.7.2.3

The last kind is an in-place family. These are created in the project-environment 

itself, with many of the basic tools you find in the Revit Family Editor. The shape 

of an in-place family and form are heavily based on and referenced to other 

project geometry. This means they are almost impossible to export or copy, 

since they are so dependent on actual project-geometry. This kind of family you 

can, for example, use when you want to create a desk element that is wrapped 

around a column. When the column is located somewhere else or the diameter 

changes, the desk will adjust accordingly. 

5.7.3 Making a window with the Family Editor 

 General 5.7.3.1

When you need a certain loadable object for your project, before creating one 

from scratch, it is best to look if there is already an object in existence that 

meets your requirements. If so, you can just make a type that meets your 

requirements, and import it in your model. 

For some objects in the State Office Building, like windows and the exterior 

doors, we decided to make a family from scratch. This ensured us that the 

eventual outcome would fully meet our needs. It was also a great opportunity to 

learn the basics of ‘family-making’ in the family editor. From tips and tricks, we 

often read that you should first make alterations to existing families before 

making a whole new one. But in our opinion, it is hard to make alterations to an 

existing family-component, if you don’t know what to change in the first place.  

 Choosing the right template 5.7.3.2

When we first made a new family, we were asked to choose a family-template, 

which is recognized by the *.rft extension. There are all kinds of family- 
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templates in Revit and choosing the right one is a very important step in the 

process. It can make your modelling so much easier and some tools will only be 

available in certain template-environments. For a window, there is a pretty 

straight-forward template, called ‘metric-window’ or ‘metric-window with trim’. 

However, it is possible to start with another template, and eventually ending up 

with the same window. It can be quiet challenging to determine what all the 

different properties of the templates are. Choosing a certain template can have 

a great impact on how your element eventually is going to behave. Besides 

templates that are named corresponding with the type of element you want to 

create, such as a window or a door, there are also templates with some extra 

descriptors, e.g. wall based, floor based, and so on. 

If you can determine how your elements have to behave in the project 

environment, you can select an appropriate template more easily.  

1. Host based 

Wall based (e.g. windows in a wall), ceiling based (e.g. light fixtures), floor 

based (e.g. heating-element) and roof based (e.g. skylights) families can only 

be placed on the element of the corresponding host type. They can cut through 

the host element if desired.  

2. Standalone  

Standalone families don’t relate to a host, and can be placed independently. 

Furniture is a great example of a standalone family. 

3. Adaptive families  

Adaptive families are used to create components that can be used for repeating 

systems using arrays and constrains. These families are made in the conceptual 

mass environment. 

4. Line-based families 

Line-based families create elements where the main geometry is attached to a 

length by specifying 2 points. 

5. Face-based 

A Face-based object can be placed on any surface of a model element in the 

project. These can also interact with other elements, for example by making 

complex cuts. 

 Start making the window 5.7.3.3

The principals of making a component in the family-editor is to make a 2D 

sketch-based form, on which you then can do some simple transformations like 

extrude, blend, revolve, sweep and a swept blend.  

To make a window in the family editor, we have to shape the elements of that 

window and be sure they behave in a parametric way. Parametric means that 

we can adjust the width or the height for example. This ensures us that we can 

make all kinds of family-types of our window-family. 

The steps to a successful family component are always the same. First we need 

to choose the right template and determine the hosting-behavior. After that, we 
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lay out our reference planes. These Reference Planes, also referred to as RP, are 

the skeleton of our component. We build and lock geometry to these planes. In 

addition, if we want to add parametric properties to our components, we add it 

to our Reference Planes. Reference Planes are the actual things that move when 

we change for example a height or a depth. The geometry is just ‘glued’ to 

these planes, and they simply follow along.  

The rough steps are as follows: 

1. Choose the right Template and hosting (wall, floor, face,…) 

2. Sketch our Reference planes and name them so we can get track of them 

3. If necessary, add parameters and constrain our Reference planes to each 

other. 

4. Add the actual geometry 

5. Test how the component behaves if we change some parametric values. 

Sometimes this testing is referred to as ‘flexing the component’. 

Our window will consist of a frame that will contain 2 sashes. In the end, we will 

add a sill to complete our window.  

 

 

 

 

 

 

 

 

Figure 5-124 – Window in Family Editor 

 

1. Choosing template 

We will start with the metric-window.rft template [5-125]. In this template, 

there is already a host-wall drawn, and we also find a cutting plane that makes 

the opening in our wall. If we would flex this rough model now, we would see 

that when you adjust height or width, the cutting plane will follow. So this 

means the cutting plane is attached to the laid-out reference planes. We flex our 

model by going to the Family Types under the properties panel and change the 

values accordingly [5-126] 
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Figure 5-125 - New family with template 

 

Figure 5-126 - Family Types 

 

2. Sketching Reference Planes 

The next thing we will do, is laying out some of our additional Reference Planes. 

The outer boundaries of the windows are already defined by the existing RP’s. 

From a plan view, we will add a reference plane, parallel with the already 

existing outer one, so we can define how deep the window will be placed in the 

wall. Another RP will define the depth of the window frame. This RP will be 

named ‘Depth Frame’. The actual geometry of the frame will thus be squeezed 

in between the ‘Depth Window’- RP and the ‘Depth Frame’-RP. These 2 

reference planes will also be part of our boundaries for our inner and outer sash.  

The inner and outer sash will therefore need 2 more Reference planes, being 

Outer Sash and Inner Sash. The Outer Sash-RP and Depth Window-RP define 

the Outer Sash Width, the Inner Sash RP and Depth Frame define the Inner 

www.iiB
IM

so
lut

ion
s.i

r



92 

  

Sash Width. Naming the reference planes is important, so we don’t accidentally 

refer to the wrong one when more reference planes are added in a later stage. 

You can add an identifier to a Reference Plane in the properties palette (when 

the RP is selected). By adding a dimension between these 2 Reference Planes 

with the Aligned Dimension Tool (shortkey DI), we make it possible to add a 

parameter to this dimension, making it adjustable [5-127]. To make a distance 

parametric, we select the placed distance and add a parameter to it by labeling 

it [5-128]. For this example we will give this parameter the same name as the 

reference plane “Depth Frame”. A point of care when you select an object or line 

is to be sure you have selected the right object or line. When you make families, 

you will often find a lot of lines drawn over each other. To select the right line or 

object, you should use the Tab-key to cycle through all objects where you are 

currently hovering over and click your mouse when the right one is lighting up. 

In the left down corner of the drawing area, you will see the identification of the 

current selected object.  

 

Figure 5-127 - Depth Frame 

 

3. Adding parameters 

Distances between these Reference planes will be tagged with a parameter 

accordingly. Finally we need 2 more Reference planes to define where our inner 

and outer glass will be. These will be placed in between the Outer Sash-RP and 

Depth Window-RP for the outer glass, and Inner Sash RP and Depth Frame for 

the inner glass. The glass needs to be in de middle of the sashes, so we make 

sure that the distances are equal with the ‘equal distance feature’ of the 

distance command. 
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Figure 5-128 – Making the ‘Depth Frame’ Parametric by adding a label 

 

 

4. Add the actual geometry 

Now that all our Reference planes are laid out, and they have been tagged with 

parameters accordingly, it is time to add some geometry. All window-geometry 

will be drawn with the extrude tool, the sill will be defined by a sweep. The way 

this works in the family editor is by first sketching the shape you want to 

extrude, and then extruding it defining the Extrusion Start and Extrusion End 

value. In which view you start drawing (an elevation view or floor plan view), is 

also important. The extruding of a shape takes place parallel with the view you 

sketched your shape in. Depending on the extruding value, the extrusion goes 

‘into your screen’ or comes ‘out of it’, so to speak. In other words, you will not 

be able to see the extrusion initially, but you have to change views, for example 

by going to the 3D-view.  

We take the window frame for example. We start of by going to the Exterior 

Elevation View. In this view we draw 2 rectangles. The outer will define our 

height and width of the frame, and we will lock these sides to the according RP. 

The inner rectangle is interpreted by the sketch as an opening. We can also 

define the relation between the inner and outer rectangle, thus defining the 

mullion width of the frame.  

First we need to define on which Reference plane we want to draw our 

geometry. In the case of the frame, we can pick the Depth Frame RP. We draw 

our inner and outer rectangle, and set them 50 mm apart with the Aligned 

Dimension tool. Then we will lock the outer sides of the rectangle to respectably 

Head-, Sill-, Left- and Right Refencence planes. These were already predefined 

in the template, and determine the outer dimensions of the window. Locking is 

done by using the Align tool (shortkey AL). First we select the reference plane 

we want to align to, then the ‘to align’ side of the rectangle. So we want each 

outer line of the rectangle to align with the right reference plane. Each time an 

alignment takes place, a lock -icon appears. This lock should be activated, so 

the geometry is ‘glued’ to the Reference plane. When the reference plane 

changes its position, the geometry will follow along. Another thing to do, is to 

define the extrusion-value. We will leave the Extrusion start to 0; and set the 

extrusion End to 165. The extrusion will ‘come out’ of the screen with 165 mm, 

which is the depth of our frame. In a similar way, the other parts of the window, 

like the sashes and the glass, are extruded, aligned/locked and set to the 

appropriate Reference Plane. 
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Figure 5-129 - Locking geometry to reference planes 

 

For the sill geometry we will use a sweep form. The principle is that you appoint 

a path [5-130A] (which is a line in our case) along which a 2D profile [5-130B] 

is ‘sweeped’. This profile can be a sketch-based shape or can be a predefined 

2D-family shape. For our purposed we will define the shape ourselves.  

 

Figure 5-130 – Sweep of the sill 

 

In the end we will have to appoint some materials to our window. In the 

properties palette, under ‘materials and finishes’ we can define the material of 

the drawn geometry. We will appoint a white paint color to the frame-geometry 

in the family editor itself. Another way to add materials to geometry, is by 

making the ‘materials and finishes- tag’ parametric. This way it is possible to 

change our material later on. For our purposes, we will fixate the material in our 

family editor itself, making it non-changeable. 
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Figure 5-131 - Frame properties 

 

5. Flexing the component 

 

It is advised that each time you add some new geometry, you flex the model. 

This way, you can ensure you are still on the right track and you can adjust if 

needed. 

 

 

Figure 5-132 - 3D result 

5.7.4 Making columns in the Family Editor 

There are two custom-shaped columns needed in the State Offices Building.  

The first one being some kind of oval shaped columns in section, which are 

situated on the ground floor (axis 12). These are actual round columns, which 

have been stretched. This is because there is a dilation joint going through 

them, and there are some movement joints incorporated in the columns. The 
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other custom shaped columns, are located on the outside.  Both columns were 

made in the Family Editor, using the same principles as with the making of the 

windows and doors. 

 

Figure 5-133 - Column result 

5.7.5 Making Tiles in the family editor 

 

Figure 5-134 - Tiles on the building 

 

Aalto is very famous for the use of ceramic tiles that are designed by himself. In 

the State Offices Building, these were used on a part of the front façade. In 

front of the windows, concrete stiles are used as a raster, which are tiled. The 

rest of the wall is also tiled. This is a very unique feature, and defines the whole 

outlook of the building. That is why we tried to reproduce it as exact as possible 

in Revit. We did some measurements on site to determine the dimensions of the 

tiles and the stiles. Then we created 2 ’face-based’ families, one for the stile and 

one for the tiles. The face-based properties of the family are ideal for the 

purpose. They will automatically orient and attach to faces they get in touch 

with. So after we made them in the family-editor and imported them into the 

project, we used arrays to put the tiles and stiles on the right place. This was a 

tedious job, but in the end we got a satisfactory result. 
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Figure 5-135 – Rendered image of the tile-façade in Revit 

 

5.8 Complex profiles in ArchiCAD 

When customizing a standard construction gets too complicated, you can create 

a complex profile. For example all the outer walls on the ground floor have a 

concrete footing. You could draw the footing and wall apart from each other, but 

in that case you’ll need to draw an extra wall which would take a lot more time. 

In ArchiCAD, we can easily create this footing as a Complex Profile. 

First we need to select the wall, beam or column that we want to edit. When the 

element is selected we can open the Complex Profile Manager by going to the 

Menu Bar, selecting Design > Complex Profiles > Profile Manager 5-136. 

Another way is by right clicking and selecting Edit Selected Complex Profile, but 

to do this, the selected element already has to be a Complex Profile.  

 

Figure 5-136 - Navigating to Profile Manager 
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The Profile Manager Dialog will now open 5-137. By clicking the Capture button 

you will be able to edit the selected element 45-137A. The Profile Editor will 

now pop up with the structure of the selected element in it 5-138. Now you 

need to draw the adjustments with the Fill Tool. So we start by selecting the Fill 

Tool, which is located in the Document group in the Toolbox. You can define the 

kind of material you want to use from the Info Box. You can also use the Pick Up 

Parameters function (see 5.2.1.5) when the material you need is already in the 

element.  

As an example, we’ll create the wall with the concrete footing. In this case, we 

can use rectangular as Geometry Method from the Info Box. Now we define our 

starting point for the footing 5-138A. Next, we have to define the height and 

width of the footing. By pressing the TAB-button, we are able to fill in exact 

measurements for the fill we want to create 5-138B. We define a height of 

175mm and a width of 120mm for the footage. By pressing the ENTER-button, 

the footing will be created.  

Now we still need to edit the bottom side of the bricks and plaster, as they still 

overlap the concrete footage. First we need to select the fill we want to adjust. 

This can be done by just clicking on a random area inside the fill 5-139A. The 

selected fill will be highlighted with a green colour. Next, we select the bottom 

line of the material as we want this to be above the concrete footage 5-139B. 

By selecting the bottom line, the Pet Palette will pop with a collection of tools 

that can be used to edit the fill. In this case, we will need to select the Offset 

Edge icon 5-139C. The next thing we do is dragging our cursor upwards and 

click on the top of the footage 5-139D. Now the brick wall will be adjusted to 

the top of the footage. The same needs to be done for the plaster as well.  

Now that the adjustments are done, we can either choose to store the profile 

or/and apply it to the selected element. Storing the profile can be useful when 

we need to have the same Complex Profile at other walls too, which is the case 

for the profile we just created. So we store and give the profile a name first 5-

137C and after that we can apply the profile on the selected wall 5-137B.  

But to use the Complex Profile for other walls, you’ll have to take some things in 

mind. Both walls need to be exact the same, having the same 

structure/thickness and height. The wall that you want to use the Complex 

Profile on needs to be drawn with the same reference line as the wall that you 

originally created the Complex Profile from. The Reference Line from a Complex 

Profile cannot bet edited and changed.  

The end result of this complex profile in 3D is shown in the figure below. A 

collection of the complex profiles we created for this project can be found in 

appendix 4. 

However, sometimes it is still better to draw 2D-details, when structures are 

getting to complicated to draw in 3D. Of course, 2D details will not affect the 3D 

geometry. 
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Figure 5-137 - Profile Manager Dialog       Figure 5-138 - Editing a Custom Profile 

 

 

Figure 5-139 - Editing the fill 

5.9 Environment 

5.9.1 General 

A model always looks nicer when it is placed in an environment. Because we 

have been able to draw our ArchiCAD model so quickly, we still had the time to 

model the surroundings. We have drawn the site plan according to the original 

plans we had. Besides that, we were able to import the other buildings of the 

Alvar Aalto Centre. These are previously modelled in 3ds Max by other students 

from the university. These models can also be found in Google Earth and can be 

downloaded from the 3D Warehouse of SketchUp.  
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5.9.2 Ground 

We need to create the surrounding grass fields and roads with the Mesh Tool, so 

we start with selecting the Mesh Tool from the Toolbox. Just as with the 

previous tools, you can define the settings from the Info Box and Settings 

Dialog. 

When the Settings Dialog is opened, you can see that it is divided into 5 groups 

5-140. In the Geometry and Positioning map you can define the thickness of 

the mesh 5-140A. In this case it doesn’t really matter how thick the mesh is, 

as long as it gives a realistic view to the project. Next you can define the offset 

of the mesh, which can be positive, negative or zero 5-140B. Defining another 

Home Story can be done right under the previous setting, but in almost every 

case it will be the easiest to define the offset from the ground floor 5-140C. 

Another possibility to locate the Home Story of our mesh is also available in this 

group 5-140D. In this tool, it is possible to define the distance relative to 

project zero, sea level, current story or other reference levels. 

On the right side of the Settings Dialog, you can define the Construction 

Method, which can be Surface Only, Surface with Skirt or a Solid Body 5-140E. 

The last thing to set up in this group is the building material 5-140F. In every 

mesh of this project, we used Sand as building material. 

To give the top side of the mesh another look you have to go to the Model 

group. In this group we can override the top, skirt and bottom surfaces. In our 

case, we need to override the top case by clicking on the top icon 5-140G. Now 

we are able to select a top surface. We used 3 different kinds of surfaces: grass, 

concrete and asphalt. 

  

Figure 5-140 - Mesh Settings Dialog Figure 5-141 - Result of the created Meshes 

 

When you are done with the settings, you can start drawing the mesh. First you 

need to choose one of the 4 Geometry Methods from the Info Box. The options 

are Polygonal, Rectangular, Rotated Rectangular and Regular Sloped. In most of 

the cases, we used Polygonal as geometry method because most of the meshes 

we need to draw are various shapes. When you define the starting point, the Pet 

Palette will show up where you can choose to draw straight or circular lines. To 

finalize the mesh you need to end up back at the starting point. 
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5.9.3 Buildings around the model 

When you download a model, you need to save this as a SketchUp 8 or earlier 

version. Only these versions of SketchUp are supported in ArchiCAD. You can 

also download the models from the website of SketchUp, but because we had to 

save the files in another format, we needed to download the models in SketchUp 

itself. After we saved the model, we can return to ArchiCAD and import the file 

by going to the Menu Bar and select File > File Special > Merge. Then we search 

for the file that needs to be imported. After the file is imported, the last thing 

you need to do, is defining the position of the model with a final click.  

But as we import the model, a part of the terrain from Google Maps around the 

building is also imported. The imported model also had photo textures on the 

facades, but in our case we didn’t want to use them. We thought that they 

attracted too much attention from our actual model. To adjust these settings, 

you will need to select the model and open the Settings Dialog from the Info 

Box. We can disable the terrain from the Custom Settings 5-142A and override 

the surface in the Model group. First, we have to disable the Select Object’s 

Surfaces 5-142B and then we can assign another material to the model 5-

142C. 

 

Figure 5-142 - Settings Dialog of the imported model 
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  Figure 5-143 - Final result with all the models imported 

5.10 Objects in ArchiCAD 

5.10.1 Using objects from the library 

One of the big advantages of ArchiCAD is the large library. A lot of objects can 

be found in the library and the amount of objects is growing every year. A big 

part of these objects have proven to be very helpful for our project, as they are 

very easy to place and edit. A lot of parameters can be adjusted specifically for 

every kind of object. The settings of the selected object will pop up at the right 

side of the Setting Dialog 5-144B. 

As we select the Object Tool and open the Settings Dialog, we can scroll to all 

the maps on the left side 5-144A. The library is divided into 3 main parts: 

Basic Library, Visualization Objects and Add-On Library. The Basic Library 

contains all kinds of furnishing (chairs, office equipment, etc.), building 

structures (fences, precast column and beam, hollow core slab, etc.), special 

constructions (ladders, rainwater pipes, elevators etc.) and 2D elements 

(electric and graphic symbols). The Visualization folder contains site 

improvements (trees, parking places, vehicles).  

Another way to search for a specific object is by typing the name of the object 

you want in the Search Bar at the top of the Settings Dialog 5-144C. This way 

you will not only search for objects in the integrated library, but also on the BIM 

Components Portal. This is a portal where everyone can upload his created 

objects. This way, you will find more and different objects. Of course internet 

connection is required for this feature. 

In our project, we’ve made use of following objects: skylight domes, ladders, 

ramps, elevator, parking places, 3D text and trees. 
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Figure 5-144 - Object Settings Dialog 

5.10.2 Creating an object 

As mentioned in the Revit-family chapter, a small part of the front façade is 

covered with ceramic tiles. In order to model these, we needed to create an 

object ourselves. You can start drawing an object within the current project or in 

a new one. As it is a rather small and easy object, we decided to draw it in the 

current project. 

It does not really matter with which tool you create the object, you just select 

the tool which you think is the easiest one to draw your object with. So we 

decided to draw the ceramic tile with the help of the Slab Tool. After selecting 

the Slab Tool, we can easily create the shape of the tile with the Polygonal 

Geometry Method. The dimensions assigned to the slab don’t really matter, as 

we can adjust the width, length and height of the object in the Settings Dialog 

later. When the shape is drawn and the slab selected 5-145A, we can save the 

slab as an object by going to the Menu Bar and select File > Libraries and 

Objects > Save Selection as > Object 5-145B. A screen will pop up where we 

have to set up a name for the object.  

The object can now be found in the library and we can define the dimensions 

and surface from the Settings Dialog of the object 5-146. Another object we 

created are the rings that are situated around the columns. The result of both is 

shown in the figure below 5-147. 
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          Figure 5-145 - Save as an object     Figure 5-146 - Settings Dialog of the tile 

 

 

 

5.11 View properties 

5.11.1 Navigating through the model 

 ArchiCAD 5.11.1.1

1. Navigating in ArchiCAD in 3D 

By default, ArchiCAD has two 3D projections views: Generic Perspective and 

Generic Axonometry. It is also possible to create new perspective views with the 

Camera Tool, but these are mainly used to create a fly-trough. You can navigate 

your way around the building with your mouse. Scrolling with the wheel will 

cause the action zoom in and out. By holding the scrolling wheel and Shift-

button at the same time, you’ll be able to turn your view and move your way 

around the building by moving your mouse. Another way to do this is by 

selecting the Orbit command from the Mini Navigator (see 5.2.1.7) or using the 

shortcut “O”. In this case you just have to click and hold the left button of your 

mouse to move around.  

Figure 5-147 Final result of the tiles and column objects 
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We always worked with the Generic Perspective as this perspective has an extra 

feature, in comparing to the Generic Axonometry view, which we used a lot. 

This feature is called Explore Model. You can select this command from the Mini 

Navigator (see 5.2.1.7) or from the Zoom Controls (see 5.2.1.8). A perspective 

view needs to be opened first before you can select this command.  

In Explore mode, you need to use the mouse and the arrow keys of the 

keyboard to navigate through the model. It is a bit the same as playing a video 

game. You can easily fly or walk through the model. This tool was very helpful 

to discover faults and errors in our model. The figure below gives you a preview 

of all the actions that are possible and how to use them 5-148. You exit the 

Explore mode by pressing ESC or by left clicking in the 3D view.  

However, it is not possible to edit an element when you are using the Orbit or 

Explore Model command. 

 

 

2. BIMx 

In most cases, only professionals will have ArchiCAD on their computer. 

Therefore it can be useful that also non-ArchiCAD users can watch the model. 

This can for example be useful for clients. This is possible with BIMx. BIMx 

allows you to view models on computers, tablets and smartphones.   

BIMx for computers can be downloaded from the Graphisoft website for free 

(www.graphisoft.com/downloads/bimx/bimx_desktop.html). A small guide of 

how to use this program, can be found in appendix 6. 

Graphisoft has recently updated the BIMx application. It is for example also 

available on the App Store and Google Play. This makes it possible to use a 

smartphone or a tablet to explore your model. The BIMx app is divided into 2 

versions. The first BIMx version is free and is recommended for clients. With this 

app, you are able to watch 3D models that are shared with you. The BIMx PRO 

Figure 5-148 - 3D explore information www.iiB
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version will cost you €49,99 and can display 2D views, as well as 3D views. 

Therefore you have access to all your plans wherever you are. Graphisoft wants 

to bring BIM into practice with this app. However, sharing and uploading a 

model onto the app is not free. For every model you want to share, you’ll have 

to pay €49,99. However, sharing models to view in the BIMx Desktop Viewer is 

free. 

 Revit 5.11.1.2

You can go into 3D view by clicking on the little house, located in the Quick 

Access Toolbar. The first time you open a 3D view in a project, a 3D-view 

dropdown will be added in your Project Browser. From now on, you can just click 

on this view in the Project Browser. If you add new 3D views, they will be added 

in this section. You can add and name as much new 3D views as you want. This 

you do by going to the 3D-viewcube. When you right click on this viewcube, you 

can make new views with a specific orientation. You can orient a view to for 

example a floor plan/elevation/section (making floor plan/elevation/section 

visible in 3D) or orient to a direction. You can safe and name these specific 

views, and they will be added to the 3D-views in the Project Browser [5-149]. 

We made a 3D view for each floor level and saved it to the list, because this is 

the only decent way to properly get into the building. 

 

Figure 5-149 – Save view 

 

To walk around in Revit, you have to create a Perspective View by placing a 

camera in the project. You go to the View tab > Create Panel > 3D view > 

Camera. You have to place the view in a 2D floorplan. Once placed, you go into 

the perspective view. This view will be added to de 3D-view section of the 

Project Browser. You can rename this view if you want, to keep things 

organized. You can walk around in this perspective view, by using the Full 

Navigation Wheel. This can be accessed by typing “Shift+W”. There are different 

tools in the Full Navigation Wheel, like walk and look. You just click the tool you 

want and keep your mouse key pressed in [5-150]. 
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Figure 5-150 - Walk around in Revit 

5.11.2 Sections 

 General 5.11.2.1

Sections are an important part of the plans, as no building can be constructed 

without sections. The advantages of these software packages come forward as 

creating sections is just as easy as dragging a line. Another advantage is that 

you are able to make 3D sections. 3D section can be very useful to edit 

particular parts of the building. It is also a nice tool to visualize details or 

particular parts of the building.  

 ArchiCAD 5.11.2.2

1. 2D section 

We start with selecting the Section Tool from the Toolbar, which is located in the 

group Document. We can create single and staggered sections. Now you just 

need to draw a Section line through the building by defining the starting and 

ending point of the Section line. After this, you only have to define the viewing 

way of the section. This can be left or right for crosswise sections, and up or 

down for longitudinal sections. Each newly created Section is listed in the 

Navigator Project Map, in the Sections part. By default, the created section will 

be linked and updated according to the floor plans, but it is also possible to 

create sections that are not linked to the floor plans. 
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Figure 5-151 - Created section on the floor plan 

 

2. 3D section  

To start, you need to activate the Cutaway tool from the Standard Toolbar. This 

will cause the displaying of the Cutting Planes handles on all four sides of the 

screens 5-152A. Now you can drag and hold one of the handles to the desired 

position. There will be a palette, in the drawing area, where you can finalize or 

cancel the cutaway. It is possible to save a cutaway after which you are able to 

open it from the Navigator’s Project Map at any given moment. Cutaways can be 

both created on the floor plans as in the 3D view. An overview of rendered 3D 

sections can be found in appendix 5. 

 

Figure 5-152 - Making a 3D Cutaway 
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 Revit 5.11.2.3

You can find the Section and elevation tool under the View tab > Create Panel > 

Section/Elevation. You add your sections and elevations to your floor plans. The 

view direction depends on the order in which you pick your start- and endpoint. 

Once a section or elevation is added, it will appear in the project browser under 

‘Sections’ or ‘Elevations’. You can rename them, so things can stay organized. 

By double clicking on the arrows of the section or elevation, you go to 

section/elevation-view. You can simply make a 3D section of 2D sections by 

going to the 3D viewcube. This is explained in the previous paragraph.  

 

Figure 5-153 - Cross-section of the  State Office Building in Revit 

 

 

 Figure 5-154 - West-elevation of the State Office Building in Revit 
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6 REVIT OR ARCHICAD? 

Comparing 2 products is always a tricky business and when we searched for 

user-experiences, we had the impression that the comparisons were always 

quite biased. It often resulted in very subjective opinions. It is true, if you are a 

long-time user of one brand of software, adaptation to another brand can feel 

strange. Most of the times, preference is also quite a personal matter. Because 

we were both new to the software-packages, we think we started less biased 

and maybe could be a little bit more objective. Nonetheless, we want to be 

careful with big statements.  The reason for this is because we probably don’t 

know half the things of what ArchiCAD and Revit can do. There were however 

some things we really liked and some things we thought that could improve. 

Furthermore, we should say we only made use of certain features of both Revit 

and ArchiCAD, and these features are mostly related to 3D modelling. So this is 

only a fraction of what we eventually will learn and discover, but it is just 

impossible to learn everything in such a short amount of time.  

We have both installed ArchiCAD and Revit on our systems, so we could both 

see how the software-packages behaved. Although this is maybe very 

subjective, and our systems are not very state of the art, we saw some clear 

differences in performance. Revit seemed to be much heavier on our computers, 

while ArchiCAD appeared very light. Although as soon as our projects files 

became bigger, and both systems started to suffer, the performance change 

was still visible. For example, we imported the same raster image-plans for our 

underlay both in Revit and ArchiCAD. In ArchiCAD, panning around on both 

computer-systems went fluently, while in Revit it was really lagging. These were 

the same files, the same size, the same quality… strange! 

ArchiCAD is available both for Microsoft Windows and Apple iOS, while Revit can 

only be installed on the Windows-platform. This can be seen as a handicap, 

since firms with iOS as their main operation system can’t choose for Revit. 

The approach on how objects are added to the models is also quite different. 

You could say that making walls, floors, columns, beams and roofs is quite 

similar. But the rest is quite different. ArchiCAD has a vast object-library 

installed inside the software. Adding and changing the look and properties of an 

object is very easy and straightforward. In contrast, Revit has a very basic 

object library. This is because of the use of the families. You have to go into the 

family editor to change and make objects. There are also a lot of websites and 

communities were you can find *.rfa files of objects. But we had the impression 

that the quality of these objects is not always guaranteed. As a Revit user, you 

have much more flexibility to make your own objects in the Family-Editor. But 

before you can make high-level objects, you have to build up experience. 

Moreover, learning how to make new families is quite tricky and theoretical, and 

in our case, it was sometimes quite frustrating. On the other hand, in ArchiCAD 

you are limited to the object library. If you want to make custom-objects, you 

have to know how to program in ‘GDL’. You could say that ‘GDL’ is the 

counterpart of the family in Revit. GDL requires programming-knowledge, and is 

not for everyone. ArchiCAD is very user friendly for building up your model, but 

cannot handle creating or editing  objects very well. In Revit it is a little bit vice 

versa, you can very flexibly build new objects, but building up a model with 

those objects can be tricky (because in the beginning your library will be 

empty). 
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So in ArchiCAD you can boast results very quickly, since it is so easy to import 

and adjust objects from the built-in library. It felt very rewarding to be able to 

get in so much detail so fast. In Revit, because of the learning curve with the 

Family-editor, results came slower. Because of this, we were able to get much 

more detail in the ArchiCAD-model. We had to leave the Revit-model in a much 

more primitive state, which was somewhat frustrating.  

Nevertheless, we really appreciated how Revit handles the drawing of new 

elements. The principle of first ‘sketching’ it approximately on the right place, 

and then using the aligned distance and align tools, really pleased us. In our 

eyes, this is one of the strong points of Revit. 

The principle of making types of a family and how they behave, is another thing 

we really liked about Revit. Changing a certain instance of a type results in 

changing all of the instances of that type. In ArchiCAD, it is also possible to 

make changes on multiple objects simultaneously, by using ‘Find & Select’. So 

both Revit and ArchiCAD have done a good job. 

On the other hand, we felt that Revit has too many dialogs all over the place, 

and you go from one dialog to another. We liked the ArchiCAD approach better, 

keeping everything nice and clean in a central window. This clearly had an 

impact on how we had to refer to certain principles in this thesis. The ArchiCAD 

pictures are always very comprehendible and clean, while in Revit we had to 

take screenshots all over the place, making things look more disorganized. 

For moving around in 3D, we have to make a clear distinction between ‘working’ 

and ‘walking around’ in 3D mode. We liked the 3D possibilities of ArchiCAD very 

much. In Revit you have to work in a 3D-axoniometric view, and you can only 

activate a perspective view if you go through some steps. You have to add a 

camera on the floor plan by going to the View tab > 3D view > Camera. In 

addition, this perspective view is not intended to be used as your main working 

area, since the possible actions you can perform are close to none. In Revit 

2016, Autodesk made it possible to Align, Move, Pin and Unpin in Perspective 

View. Although, this is a good start, this is still very disappointing. In ArchiCAD, 

every single manipulation can be done in Perspective and Axonometric view, 

and switching goes with a click of a mouse button. Revit can still learn quite 

some things from ArchiCAD on this part. 

Also the exploring of your model is done in different way. Also on this part, 

ArchiCAD has done a great job. You can just activate the ‘Explore Model’-Mode, 

and then you can just start running around like if you are in a videogame, using 

mouse and your keys ZQSD (Azerty-layout). In Revit, you first have to be in 

perspective view, so you first have to make a view by going to the View-tab 

>3D view > Camera. Then you can access the ‘Full Navigation Wheel’ and using 

your mouse to go over the different navigation actions. So all navigation has to 

be done with your mouse, and no keys are involved. This way, you can only do 

one action at a time, which feels very unnatural. It also happened more than 

one time, that if we were a little bit to brusque, we ended up in some place of 

the model we did not want to be. Sometimes we were even lost, and had to exit 

this mode, only to start a new view back from where we started. We had the 

impression you have to purchase a 3D-mouse to fully harness the use of the3D 

perspective-navigation in Revit. So in ArchiCAD, it is a joy to walk around in 

your model, doing adaptations and controlling your work. In Revit it is rather 

stressful and not practical at all. This results in a very different working 

approach. 
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CONCLUSION…. 

In this thesis, we learned a great deal about the different features that both 

Autodesk Revit and Graphisoft ArchiCAD have. We started with doing some 

measurements, to know if the old architectural plans were reliable to base our 

model on. We also learned more about point cloud data and how it is collected 

on site. The modelling in both software packages boasted some great results.  

Although both ArchiCAD and Revit have some very similar features and tools, 

there are also some differences. In Revit, we saw that the learning curve was a 

little bit higher due to the use of the somewhat technical Family Editor. Also 

because we had to make a lot of custom objects in Revit, we had to spend much 

more time on certain objects than in ArchiCAD. On the other hand, the Family 

Editor gives you a lot of flexibility and freedom. We can imagine that, once fully 

mastered, the possibilities of the Family Editor are endless. The fast buildup of 

the ArchiCAD model is partly due to the vast object library inside the software. 

It was very easy to specify all kinds of details on windows and doors. Also 

importing objects like skylights, trees and ladders, was very straightforward. We 

also learned that Revit was a little bit heavier on our hardware than ArchiCAD.  

Furthermore, both ArchiCAD and Revit handle the actual drawing and 

positioning of new objects pretty well. However, Revit did a particularly good 

job. The Aligned Dimension and Align-tool in Revit are really of great value. Also 

the different approaches on exploring and working in 3D were interesting to see. 

We saw that ArchiCAD has done a marvelous job on this part. Being able to run 

around in your model, as if it is a videogame, gives you a lot of power. In Revit, 

the 3D-navigation seemed a little bit more primitive. Also the lack of editing in 

perspective view surprised us.  In the end, we learned a great deal about the 

different modelling techniques in Revit and ArchiCAD.  

Being able to spend so much time with ArchiCAD and Revit, resulted in gaining a 

lot of experience in 3D-modelling and BIM. We hope this knowledge and 

experience are a starting point in our further careers as BIM modellers or in a 

BIM-related job. 
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APPENDICES 

Appendix 1: results of the measurements 
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Appendix 2: technical details of laser scanning system 

 

Dr. Antero Kukko 

Finnish Geospatial Research Institute FGI 

Antero.Kukko@nls.fi 

 

Technical details for AkhkaR2 Personal Laser Scanning (PLS) system 

The data for Seinäjoki project was collected using AkhkaR2 system that is a 

backpack application of mobile laser scanning (MLS). To make kinematic data 

collection possible the system needs to have a positioning system coupled with 

the data collection instrumentation. 

The AkhkaR2 system uses GNSS-IMU (Global Navigation Satellite System-

Inertial Measurement Unit) positioning to track the platform movement during 

the survey. Positioning data is post-processed with correction data from virtual 

GNSS base station service for accurate system trajectory with precise attitude at 

200 Hz frequency. The Trajectory data contains the position (Easting, Northing, 

and Elevation) and attitude (Roll, Pitch, and Heading) of the platform as a 

function of time. The trajectory data is timed in essence by the GPS time, and 

timing of the laser data is carried out by TTL level signal sent by the scanner for 

each of the profile and recorded by the GNSS receiver event logging. 

The laser scanner mounted on the system for this project was FARO Focus 3D 

X330 (Figure 1). In MLS the laser scanner operates in so called helical scan 

mode, which in effect means it senses the surroundings with cross-track profiles 

at 95 Hz scan frequency. The point measurement rate used was 488 kHz, giving 

1.2 mrad angular resolution, i.e., 30 mm point spacing at 25 m distance from 

the scanner. In addition to 3D coordinates, the scanner also records the 

intensity of the returned laser signal. In a typical case the point precision is a 

few millimetres, seen clearly from the point cloud illustrations in Figures 2-4, the 

positional accuracy being typically about 20 mm. 

 

Figure 1. Backpack mounted AkhkaR2 PLS system comprises GNSS-IMU 

positioning system and laser scanner to capture detailed and accurate 3D data 

for virtual modeling and mapping. (Photo M. Matilainen 2013) 
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Figure 2. Valtion virastotalo measured with AkhkaR2 personal laser scanning 

system 11. 5.2015. The point cloud represents the geometry of the building 

precisely and captures the prominent features well. The points are colored by 

the laser intensity and data file number (data is split in to files containing 3000 

profiles each) to illustrate the progress of the data collection. Data collection 

took about 4 minutes. (Image A. Kukko, 2015) 

 

Figure 3. Point cloud colored by laser intensity in grey scale. What could be seen 

in this figure is that as the data collection was carried out from the street level 

the wall of the third floor is only partially captured due to the shape of the front 

façade of the building. Such data caps could be captured by collecting data from 

the roof as well. (Image A. Kukko, 2015) 
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Figure 4. Some details of the building illustrating the system capability to 

capture three dimensional features. (Image A. Kukko, 2015) 
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Appendix 3: original plans from Alvar Aalto Foundation 

 

Floor plans 
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Elevations 
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Site plan 
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Appendix 4: overview of complex profiles 

 

Complex profile 1 

  
 

Complex profile 2 

  
 

Complex profile 3 
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Complex profile 4 

  
 

Complex profile 5 

  
 

Complex profile 6 

  
 

 

 

 

 

 

 

 

 

www.iiB
IM

so
lut

ion
s.i

r



128 

  

 

Complex profile 7 

  
 

Complex profile 8 
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Appendix 5: renders of the final result 

 

Outside of the building in ArchiCAD 
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Cutaways in ArchiCAD 
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Outside of the building in Revit 
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Cutaways in Revit 
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Appendix 6: Using guide for BIMx 

 

 

 
 

 

 

www.iiB
IM

so
lut

ion
s.i

r



140 

  

 
Appendix 7: CD-ROM with Revit- and ArchiCAD-files 
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